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ГЛАВА 1 

 

ВВЕДЕНИЕ 

 

1.1. Программа LS-DYNA 

 

1.1.1. Применение программы LS-DYNA 

 

LS-DYNA - многоцелевая программа предназначенная для анализа 

нелинейного динамического отклика трехмерных неупругих структур. 

Полностью автоматизированный процесс решения контактных задач, а 

также множество функций по проверке получаемого решения позволяют 

успешно решать сложнейшие задачи удара, разрушения, формообразова-

ния и т.п. 

 

1.1.2. История разработки 

 

LS-DYNA берет свое начало от программы DYNA3D, разработан-

ной доктором Джоном О. Холквистом (John O. Hallquist) в Ливерморской 

национальной лаборатории имени Лоуренса в 1976 г. Программа предна-

значалась для моделирования воздействия ударной волны ядерной бомбы 

изменяемой мощности, сбрасываемой с малой высоты, разработкой кото-

рой занималась в то время Лаборатория. В то время еще не существовало 

программ трёхмерного моделирования для симуляции ударного воздей-

ствия. Несмотря на то, что проект бомбы изменяемой мощности был от-

менен, разработка программы DYNA3D продолжилась. Одновременно 

разрабатывалась двухмерная версия программы под названием DYNA2D 

[2]. 

Первая версия программы вышла в августе 1976 года. 

В 1989 году по инициативе Министерства энергетики США с целью 

передачи правительственных наработок в промышленность было основа-

но акционерное общество Livermore Software Technology Corporation 

(LSTC) для продолжения разработки программы DYNA3D в качестве 

https://ru.wikipedia.org/wiki/%D0%9B%D0%B8%D0%B2%D0%B5%D1%80%D0%BC%D0%BE%D1%80%D1%81%D0%BA%D0%B0%D1%8F_%D0%BD%D0%B0%D1%86%D0%B8%D0%BE%D0%BD%D0%B0%D0%BB%D1%8C%D0%BD%D0%B0%D1%8F_%D0%BB%D0%B0%D0%B1%D0%BE%D1%80%D0%B0%D1%82%D0%BE%D1%80%D0%B8%D1%8F
https://ru.wikipedia.org/wiki/%D0%9B%D0%B8%D0%B2%D0%B5%D1%80%D0%BC%D0%BE%D1%80%D1%81%D0%BA%D0%B0%D1%8F_%D0%BD%D0%B0%D1%86%D0%B8%D0%BE%D0%BD%D0%B0%D0%BB%D1%8C%D0%BD%D0%B0%D1%8F_%D0%BB%D0%B0%D0%B1%D0%BE%D1%80%D0%B0%D1%82%D0%BE%D1%80%D0%B8%D1%8F
https://ru.wikipedia.org/wiki/%D0%AF%D0%B4%D0%B5%D1%80%D0%BD%D0%B0%D1%8F_%D0%B1%D0%BE%D0%B5%D0%B3%D0%BE%D0%BB%D0%BE%D0%B2%D0%BA%D0%B0_%D0%B8%D0%B7%D0%BC%D0%B5%D0%BD%D1%8F%D0%B5%D0%BC%D0%BE%D0%B9_%D0%BC%D0%BE%D1%89%D0%BD%D0%BE%D1%81%D1%82%D0%B8
https://ru.wikipedia.org/wiki/%D0%AF%D0%B4%D0%B5%D1%80%D0%BD%D0%B0%D1%8F_%D0%B1%D0%BE%D0%B5%D0%B3%D0%BE%D0%BB%D0%BE%D0%B2%D0%BA%D0%B0_%D0%B8%D0%B7%D0%BC%D0%B5%D0%BD%D1%8F%D0%B5%D0%BC%D0%BE%D0%B9_%D0%BC%D0%BE%D1%89%D0%BD%D0%BE%D1%81%D1%82%D0%B8
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коммерческой версии под названием LS-DYNA3D. Позднее это название 

было сокращено до LS-DYNA [2]. 

С 1996 г. решатель LS-DYNA встроен в пакет программ ANSYS, 

где используется для решения задач динамического анализа. 

 

1.1.3. Основные направления применения LS-DYNA 

 

 нелинейная динамика, тепловые задачи, разрушение, развитие 

трещин, контакт;  

 статика и квазистатика;  

 эйлеровские свойства (Eulerian);  

 произвольное Лагранж-эйлеровское поведение (Arbitrary La-

grangian-eulerian (ALE));  

 акустика в реальном масштабе времени;  

 многодициплинарный анализ: прочность, теплофизика, аку-

стика. 

 

1.1.4. Основные приложения LS-DYNA 

 

 оценка сопротивляемости удару [2];  

 анализ безопасности пассажира;  

 формование металла;  

 резка металла;  

 задачи о вылете лопатки турбинных двигателей;  

 птицестойкость;  

 расчет тонкостенных, жестяных контейнеров;  

 производство автомобильных комплектующих;  

 проникновение; формование стекла;  

 пластики;  

 биомедицинские приложения;  

 взрывная нагрузка;  

 анализ ячеистых, сотовых и тонкостенных кессонных кон-

струкций;  

https://ru.wikipedia.org/wiki/ANSYS
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 точечно-сварные, заклепочные и болтовые соединения;  

 инженерный расчет изделий народного потребления;  

 взаимодействие потоков жидкости и газа с конструкцией;  

 моделирование землетрясений;  

 расчет грузовых контейнеров. 

 

 

1.2. Методы расчета в LS-DYNA 

 

В LS-DYNA реализованы следующие методы [28]:  

 явный метод конечных элементов с возможностью построе-

ния лагранжевой, эйлеровой и гибридной сетки; 

 неявный (прямой с учетом разреженности матриц, итерацион-

ный - преопределенных сопряженных градиентов); 

 многокомпонентная гидродинамика; 

 бессеточный метод сглаженных частиц Smoothed Particle 

Hydrodynamics (SPH); 

 бессеточный метод, основанный на методе Галеркина (SPG, 

EFG).  

 методы discrete element method (DEM), CESE, ICFD, EM и др. 

Программа имеет встроенные процедуры автоматической пере-

стройки и сглаживания конечно-элементной сетки при вырождении эле-

ментов, высокоэффективные алгоритмы решения контактных задач, ши-

рокий набор моделей материалов, возможности пользовательского про-

граммирования. 

Для решения динамических задач многокомпонентной гидродина-

мики в LS-DYNA реализованы эйлеровые и произвольные лагранжево-

эйлеровые сетки (Arbitrary Lagrangian-Euleran), которые лежат в основе 

используемого для решения подобных задач метода - Mulimaterial Euleri-

an Hydrodynamics (MEH). Для решения динамических задач многокомпо-

нентной гидродинамики может быть использован метод SPH. 

Для решения нелинейных квазистатических и статических задач 

механики деформируемого тела может быть использован неявный реша-

тель.  

https://ru.wikipedia.org/wiki/%D0%9C%D0%B5%D1%82%D0%BE%D0%B4_%D0%BA%D0%BE%D0%BD%D0%B5%D1%87%D0%BD%D1%8B%D1%85_%D1%8D%D0%BB%D0%B5%D0%BC%D0%B5%D0%BD%D1%82%D0%BE%D0%B2
https://ru.wikipedia.org/w/index.php?title=%D0%9B%D0%B0%D0%B3%D1%80%D0%B0%D0%BD%D0%B6%D0%B5%D0%B2%D1%8B_%D0%BA%D0%BE%D0%BE%D1%80%D0%B4%D0%B8%D0%BD%D0%B0%D1%82%D1%8B&action=edit&redlink=1
https://ru.wikipedia.org/w/index.php?title=%D0%AD%D0%B9%D0%BB%D0%B5%D1%80%D0%BE%D0%B2%D1%8B_%D0%BA%D0%BE%D0%BE%D1%80%D0%B4%D0%B8%D0%BD%D0%B0%D1%82%D1%8B&action=edit&redlink=1
https://ru.wikipedia.org/w/index.php?title=%D0%9C%D0%B5%D1%82%D0%BE%D0%B4_%D1%81%D0%B3%D0%BB%D0%B0%D0%B6%D0%B5%D0%BD%D0%BD%D1%8B%D1%85_%D1%87%D0%B0%D1%81%D1%82%D0%B8%D1%86&action=edit&redlink=1
https://ru.wikipedia.org/wiki/%D0%9C%D0%B5%D1%82%D0%BE%D0%B4_%D0%93%D0%B0%D0%BB%D1%91%D1%80%D0%BA%D0%B8%D0%BD%D0%B0
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Новые методы расчета появившиеся в новом решателе ls971 R7: 

discrete element method (DEM), CESE, ICFD, EM. 

Метод CESE используется для решения многих типов задач текучей 

среды, таких как движение детонационных волн, взаимодействие удар-

ных и акустических волн, кавитационные явления в жидкости, возникно-

вение сверхзвуковых струй жидкости и истечение химически реагирую-

щих веществ. В программе LS-DYNA этот метод применяется для реше-

ния проблем взаимодействия текучей среды с конструкцией (FSI). 

Метод ICFD предназначен для несжимаемой текучей среды, до-

ступна также базовая модель турбулентности. 

Метод EM предназначен для анализа задач электромагнетизма. 

Решатели для решения химических задач и для описания стохасти-

ческого (вероятностного) поведения частиц используются совместно с 

решателем для сжимаемой текучей среды. Каждый из решателей обеспе-

чивает связывание с решателем задач механики, реализованным в про-

грамме LS-DYNA. 

 

1.3. Основы теории явного метода динамики 

 

LS-DYNA является нелинейным переходным динамическим конеч-

но-элементным кодом c явным и неявным решателем. 

 

1.3.1. Процедура расчета явного анализа 

 

Явный метод работает когда присутствует ускорение. 

При динамической задаче решается следующее уравнение [4]: 

nnnn fkdcvma    (1.1) 

где m - матрица масс, c – матрица демпфирования, k – матрица 

жесткости, а – ускорения, v – скорость, d – перемещение, n – временной 

шаг; 

nkd  - внутренняя сила в конструкции. 

Основная задача в определении перемещения 1nd  во времени 1nt : 

,...),,,,( 111   nnnnnn vdavdfd   (1.2) 
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Все термины известны во временном состоянии n и таким образом 

могут быть решены напрямую (явно). 

В явном подходе внутренние и внешние силы суммируются в каж-

дой узловой точке, и узловые ускорения вычисляются путем деления на 

массу узла (рис. 1.1). Решение продвигается путем интегрирования этого 

ускорения во времени [5]. Максимальный размер временного шага огра-

ничен условием Куранта. Расчет, как правило, требует много относи-

тельно быстрых шагов по времени. Используя условие Куранта решение 

стабильно. 

 
Рис. 1.1. Блок-схема для выполнения явного анализа [4] 

 

Последовательность расчета явного анализа: 

1. В начальный момент времени (t=0) напряжения, скорости, уско-

рения равны нулю или соответствуют заданным граничным условиям в 

момент времени t=0; 

2. Проходит временной шаг n+1; 

3. Рассчитываются скорости и перемещения в момент времени 

n+1/2 для скорости и n+1 для перемещения; 

4. Рассчитываются скорость деформации во время n+1/2 от скоро-

сти и матрицы B (матрица напряжение - перемещение); 
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5. Рассчитывается напряжение во время n+1 в зависимости от ско-

рости деформации; 

6. Рассчитываются внутренние силы во время n+1 в зависимости от 

напряжения и матрицы B; 

7. Вычисляются внешние силы в момент времени n+1; 

8.  Вычисляются ускорения исходя из разницы сил и массы; 

9. Величина временного шага увеличивается на n+1 и цикл повто-

ряется. 

 

1.3.2. Временной шаг интегрирования 

 

Приведенная выше процедура интегрирования уравнения движения 

является условно стабильной, поскольку обеспечивает получение резуль-

татов лишь при выполнении CFL-условий (Куранта-Фредри-КСА-Леви) 

[6]: 

 < max   (1.3) 

 

CFL-условие требует, чтобы шаг интегрирования не превышал от-

резок времени, за который волна проходит через элемент. Такая волна 

напряжений распространяется со скоростью звука с. Однако в общем 

случае точное значение max  для отдельного элемента вычислить невоз-

можно. Поэтому на практике используют оценку max  вычисленную по 

приближенным формулам: 

cL /max     (1.5)     

где с – скорость звуковой волны в материале, L – характерный раз-

мер конечного элемента. 

В зависимости от размерности задачи и формы конечного элемента 

скорость звуковой волны и характерный размер конечного элемента оце-

ниваются различными зависимостями: 

- для 2D задачи плоского деформирования состояния упругого тела: 

 21 V

Е
с





;   (1.6) 
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(скорость звука зависит от модуля Юнга, плотности, коэффициента 

Пуассона) 

- для 3D задачи деформированного состояния упругого тела: 

 
  VV

VЕ
с

211

1







;  (1.7) 

- характерный размер плоского четырех угольного элемента может 

быть вычислен так: 

),,,max( 4321 aaaa

A
L   или 

),max( 21 DD

A
L  ;   (1.8) 

где ai – длина стороны конечного элемента, Di – длина диагонали 

конечного элемента, А – площадь конечного элемента, Е – модуль упру-

гости, V - коэффициент Пуасонна,  - плотность. 

Максимально допустимый шаг интегрирования max  определяется 

как минимально допустимый у всех конечно-элементных моделей, кото-

рые могут деформироваться. 

 imaxmax min     

 

1.3.3. Массовое масштабирование 

 

Массовое масштабирование используется для уменьшения времени 

расчета и заключается во внесении искусственного массы. Например, для 

4-х угольного элемента: 

c

L
 , 

 21  





EL
c , 

 21 






E

L
TSSFAC  

Массовое скалирование очень полезно и позволяет напрямую уве-

личить временной шаг. 

Варианты использования: 

1. Увеличить плотность материала. Можно использовать не для 

динамического моделирования (т.е. там, где эффекты инерции 

незначительные); 
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2. Непосредственно ввести величину временного шага (отрица-

тельная величина DT2MS на карте *Control_timestep). Отрица-

тельное значение позволяет увеличить массу мелких и жестких 

элементов. 

Таким образом, добавляются искусственные силы инерции. Это 

означает, что нужно использовать их с осторожностью. 

Для задач ударов и краш-тестов рекомендуется, чтобы добавочная 

масса не превышала 5% от массы системы или 10% от массы любой ча-

сти. Но по опыту работы для задач обработки материалов давлением 

временной шаг можно увеличивать кратно (в 10-20 раз), что связано с от-

носительно малыми скоростями деформирования в данных процессах. 

Добавочная масса может быть отслежена в *Database_ASCII. Glstat 

для все модели и Matsum для отдельных частей. 

Для включения вывода добавленной массы установить в 

*Database_extent_binary параметр STSST=3 и MSSCL=2 (или 1). 

При расчете в LS-DYNA будет использована наименьшая величина 

временного шага (соответствует наименьшему элементу). 
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ГЛАВА 2 

 

ВВЕДЕНИЕ В LS-DYNA 

 

2.1. Структура программы LS-Dyna 

 

Программа LS-DYNA содержит в своем составе модуль для под-

готовки исходных данных (preprocessor), модуль решения (solver) и мо-

дуль анализа результатов расчета (postprocessor). При стандартной 

установке открывается программа оболочка – LS-DYNA Program Man-

ager (рис. 2.1), с помощью которой пользователь может вызывать пре-, 

постпроцессор и модуль решения [7]. 

 

 

 

Рис. 2.1. Панель LS-DYNA program manager 

 

Особенностью LS-DYNA является то, что исходная информация о 

задаче передается от препроцессора к модулю решения в виде тексто-

вого файла. Это позволяет легко корректировать исходную информа-

цию с помощью обычного текстового редактора. В текстовом виде также 

представлена информация о координатах узлов, элементах. Такая мо-

дель может быть подготовлена с помощью любого препроцессора, 

например LS-PREPOST [8, 9] или ANSYS [10]. 

Можно использовать и другие программы – оболочки, связываю-

щие с LS-DYNA. Например, программа k-runner [1]. 
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Текстовый файл для LS-DYNA (рис. 2.2.) обычно вводится в фор-

мате карт (ключевых слов), в котором вводятся команды и параметры для 

них. Карты пишутся в отдельных строках, каждая карта начинается с 

символа "*" в 1-й позиции строки. После карты может идти одна или не-

сколько строк исходных данных. При наличии в строке нескольких пара-

метров они записываются в отведенных им местах (каждый параметр от-

водится 10 позиций) или через запятые. Строки, содержащие в 1-й пози-

ции символ "$" являются комментариями и не учитываются при обработ-

ке файла. 

 

*KEYWORD 

*TITLE 

$#                                                                         title 

LS-DYNA keyword deck by LS-PrePost 

*CONTROL_ACCURACY 

$#     osu       inn    pidosu      iacc     

         1         4         0         0 

 

Рис. 2.2. Пример k-файла 

 

Порядок карт во входном файле для LS-DYNA значения не имеет. 

Важна лишь полнота данных. 

 

2.2. Этапы проведения расчета 

 

Выполнение процесса моделирования состоит из 3-х основных эта-

пов: 

1. препроцессорная подготовка; 

2. решение задачи; 

3. постпроцессорная обработка. 

1. Препроцессорная подготовка включает в себя создание геомет-

рической и конечно-элементной модели процесса, определение типов 

элемента, моделей материала, контактных параметров процесса, введение 

ограничений и нагрузок, действующих на модель, определение времени 

расчета и всех других необходимых параметров для выполнения расчета. 
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2. Решение задачи позволяет запустить и контролировать процесс 

решения. 

3. Постпроцессорная обработка позволяет в графическом виде по-

лучить результаты выполненного расчета путем построения графиков и 

создания анимации процесса и прочее. 

При выполнении моделирования в качестве препроцессора и пост-

процессора используется препостпроцессор LS-PREPOST (или любой 

другой), а при решении задачи используется решатель LS-DYNA. 

 

2.3. Структура файлов 

 

Ввод исходных данных с помощью ключевых слов создает гибкую, 

логически организованную и простую для понимания структурирован-

ную базу данных. Сходные понятия сгруппированы под одним и тем же 

ключевым словом. Например, ключевое слово *ELEMENT относится к 

таким конечным элементам, как объемные, балочные и оболочечные 

элементы, пружины, демпферы, и сосредоточенные массы [28]. 

Руководство пользователя программы LS-DYNA описывает в алфа-

витном порядке последовательно организованные разделы входных дан-

ных. Каждый раздел относится к определенной части исходных данных. 

Имеется раздел для переустановки параметров программы LS-DYNA; 

раздел материалов для ввода действующих постоянных; раздел уравне-

ний состояния; раздел элементов, в котором задаются идентификаторы 

элементов и узловые связи; раздел для задания составных частей струк-

туры, (конструкции) и т.д. [28].  

Блок данных начинается с ключевого слова, за которым следуют от-

носящиеся к нему исходные данные. Следующее ключевое слово, обнару-

женное при считывании блока данных, определяет конец этого блока и 

начало нового. Признаком ключевого слова является символ * в первой 

колонке карты ввода. Знак доллара $ в первой колонке предшествует 

комментарию и указывает на то, что данная строка ввода должна игнориро-

ваться. Блочная организация данных не является обязательной для про-

граммы LS-DYNA, но это можно использовать для удобства пользователя, 

давая возможность группировать узлы и элементы. Можно расположить, к 
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примеру, все задаваемые узлы под одним ключевым словом *NODE или 

вводить ключевое слово *NODE перед каждым отдельным узлом. Порядок 

ввода исходных данных произволен за исключением необязательного клю-

чевого слова *END, которое указывает на окончание входного потока. 

При отсутствии слова *END завершение ввода происходит при обнаруже-

нии признака конца файла при считывании. 

Рисунок 2.3 демонстрирует общие принципы организации ввода и 

связь различных объектов. На этом рисунке данные, объединены ключе-

вым словом *ELEMENT, представляют собой следующее: идентификатор 

элемента EID, идентификатор части PID и идентификаторы узловых точек 

NID, которые определяют узлы N1, N2, N3 и N4. Идентификаторы узловой 

точки задаются в разделе *NODE, в котором каждый такой идентификатор 

должен быть указан только единожды. Составная часть структуры, задан-

ная ключевым словом *PART, имеет уникальный идентификатор PID, 

идентификатор сечения SID, идентификатор материала или его определя-

ющей модели MID, идентификатор уравнения состояния EOSID и иден-

тификатор контроля искажений формы элемента hourglass HGID. Ключе-

вое слово *SECTION определяет идентификатор сечения SID с указанием 

формулировки элемента, коэффициент сдвига SHRF, способ численного 

интегрирования NIP и т.д. Определяющие константы материалов задаются 

в разделе *MAT, в котором указываются соответствующие исходные дан-

ные для всех типов элементов, включая объемные, балочные, оболочечные, 

толстостенные оболочечные, ремни безопасности, пружины и демпферы. 

Уравнения состояния, которые используются только для указанных в раз-

деле *MAT материалов для объемных элементов, приводятся в разделе 

*EOS. Так как многие элементы в программе LS-DYNA используют пони-

женное интегрирование, то могут появляться моды деформаций с нулевой 

энергией. Эти моды подавляются введением искусственной жесткости или 

вязкости, которые препятствуют появлению нежелательных форм дефор-

маций. Такой контроль искажений типа песочных часов может быть вы-

бран с помощью раздела *HOURGLASS [28]. 

В процессе запуска на расчет, когда считываются исходные данные, 

выполняется проверка данных, поскольку эти данные должны быть, прежде 

всего, размещены в памяти в виде массивов и затем упорядочены. Исход-
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ные данные выводятся в файл D3HSP. Пользователю следует всегда про-

верять выходные файлы D3HSP или MESSAG на наличие в них слова 

“Error”. 

 

 
 

Рис. 2.3. Организация ввода с помощью ключевых слов [28] 

 

Для лучшего понимания идеи использования ключевых слов ниже 

приводится краткий обзор некоторых основных ключевых слов [28]. 

 

Ключевое слово Описание 

*BOUNDARY 

 

Эта карта применяется для различных методов 

определения нагружения, описания граничных со-

стояний. Также существуют возможность узлового 

ограничения в секции *NODE 

*CONSTRAINED 

 

Используется для определения связных степеней 

свободы. Для примера, узловые твердые тела, за-

клепки, сварные точки, линейные ограничения, и др. 

*CONTACT Задает способ обработки контактного взаимодей-

ствия между частями модели 

*CONTROL Опции доступные в секции *CONTROL устанавли-

вают глобальные параметры, такие как время за-

вершения, величина временного шага, тепловые 

настройки процесса и др. 

*DAMPING Определяет демпфирование глобально или для каж-

дой части 

*DATABASE Это слово с комбинацией опций может быть ис-
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пользовано для контролирования выходных данных 

ASCII и бинарных файлов в LS-DYNA. Устанавли-

вается частота записи выходных параметров. 

*DEFINE Эта секция используется для определения графиков 

(нагружения от времени, температуры и др.). 

*ELEMENT Определяются идентификаторы (части) и узлы для 

всех оболочечных, объемных и других элементов 

*EOS Эта секция читает параметры уравнения состояния. 

Уравнение состояния определяется, EOSID, указа-

ние в карте *PART 

*HOURGLASS Определяет искажение и свойства объемной вязко-

сти. Индификатор, HGID, на *HOURGLASS карте 

относится к HGID на *PART карте 

*INCLUDE Делает входной файл легко сохраняемым, это клю-

чевое слово позволяет входному файлу быть разде-

ленным на подфайлы. Каждый подфайл может быть 

разделен еще на подфайлы и т.д. Эта опция удобна, 

если входные данные очень большие 

*INITIAL Определение начальных параметров модели, напри-

мер, начальной скорости, температуры 

*LOAD Эта секция снабжает различными методами нагру-

жения структуры с концентрированными точечны-

ми нагрузками, распределенными давлениями, 

инерционными нагрузками и тепловыми нагрузками 

*MAT Эта секция позволяет определять константы для 

всех материалов доступных в LS-DYNA, включая 

пружинные, демпферные и др. Индификатор мате-

риала, MID, на карте *PART 

*NODE Определяет узловые точки и их координаты 

*PART Связывает part ID с картами *SECTION, 

*MATERIAL, *EOS и *HOURGLASS 

*SECTION Определение свойств поперечного сечения: тип и 

формулировка элемента, толщина и др. 
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*SET Определение групп, узлов, наборов, сегментов 

  

Семинар 1 Осадка заготовки в 2D постановке 

 

2.4. Применение препроцессора ls-prepost 

 

Для создания моделей можно использовать бесплатный, для поль-

зователей LS-DYNA, препострпроцессор LS-PREPOST (рис. 2.4). 

  

 
 

Рис. 2.4. Программа LS-PREPOST версии 4.3 и выше 

 

Использование графического интерфейса LS-PREPOST пользовате-

ля является наиболее простым способом создания k-файла для LS-DYNA.  

 

2.4.1. Возможности ls-prepost как препроцессора 

 

LS-PREPOST позволяет выполнить большинство действий для со-

здания конечно-элементной модели и k файла (построение справочной 

геометрии, построение кривых, построение поверхностей, построение 



 20 

объемных тел, редактирование модели, нанесение сетки,  создание эле-

ментов и др. 

 

 2.5. Единицы измерения 
 

Для работы в программе LS-DYNA необходимо корректно задавать 

все используемые единицы измерений. Размерность каждой единицы 

должна быть соответственной и согласовываться с общими правилами 

[28]: 

- [усилие] = [масса]*[ускорение]; 

- [ускорение] = [длина]/[время
2
]. 

Примеры некоторых из согласованных единиц измерений приведе-

ны в табл. 2.1, [13] 

Таблица 2.1 

Примеры согласованных единиц измерений 
 

№ масса длина время усилие напряж. плотн. 
Мод. 

Юнга 

Уск. св. 

пад. 

Энер-

гия 

1 кг м с H Па 7,83е+3 2,1е11 9,8 Дж 

2 г см мкс 1е+7 Мбар 7,83 2,1 9,8е-10 Дж*е5 

3 тонна мм с Н МПа 7,83е-9 2,1е5 9,8е3 Дж*е-3 

4 кг мм мс kН ГПа 7,83е-6 2,1е2 9,8е-3 Дж 

 

Система единиц измерений №1 соответствует системе СИ. В ряде 

случаев использовать ее не совсем удобно, например, при небольших 

размерах модели и при моделировании кратковременных процессов. 

Система единиц измерений №2 обычно применяется в процессах 

длящихся очень малое время (мкс и мс), например, в процессах взрыва.  

Система единиц измерений №3 наиболее удобна в процессах ОМД. 

Система единиц измерений №4 удобна в процессах механообработ-

ки. 
 

Семинар 2 Сеточное моделирование в LS-PREPOST 

Семинар 3 Осадка заготовки в 3D постановке (простая модель) 

Семинар 4 Простая модель ударного взаимодействия в 2d по-

становке 
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ГЛАВА 3 

 

СОЗДАНИЕ СЕТОЧНОЙ ГЕОМЕТРИИ 

 

3.1. Требования 

 

Одним из наиболее важных этапов в конечно-элементном анализе 

является построение сеточной модели из конечных элементов, т.е. разде-

ление всей модели на маленькие кусочки (конечные элементы), связан-

ные между собой в узлах [14]. 

В существующих препроцессорах имеется два основных метода по-

строения сетки: построение произвольной сетки и построение упорядо-

ченной сетки. 

Произвольная сетка строится автоматически, при этом соседние 

элементы могут существенно отличатся по размерам. Упорядоченная 

сетка строится путем деления геометрических элементов на модели на 

некоторое число частей. 

Очевидно, что чем меньше линейный размер конечного элемента, 

тем большее количество элементов в модели, при этом время вычисления 

экспоненциально возрастает, а ошибки анализа уменьшаются. Однако 

ошибки уменьшаются не до нуля, т.к. с увеличением числа элементов 

накапливаются ошибки округления. 

Рекомендации при построении сетки конечных элементов: 

- сетка должна быть разумной (адекватной) 

- упорядоченная сетка более предпочтительна, чем произвольная 

(рис. 3.1) 

- необходимо избегать по возможность треугольной сетки для обо-

лочечных элементов. Не более 10%. 

- необходимо избегать тетраэдрической формы для объемных эле-

ментов. Не более 10%. 

- размеры элементов желательно иметь одинаковой формы; 

- при возникновении искажения “типа песочных часов” использу-

ются полноинтегрированные элементы (если не помогает контроль пара-

метров искажения); 
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- динамический расчет (в LS-DYNA) требует построения более точ-

ной сетки; 

- при построении сетки правило: размеры соседних элементов не 

должны меняться более чем в 2 раза; 

- для улучшения сетки (в процессе деформирования) может приме-

няться адвективное перестроение или ALE метод. 

 
Рис. 3.1. Примеры конечно-элементных сеток [14]: а – произвольная, б – упорядо-

ченная 

 

Для уменьшения погрешности вычисления рекомендуется стре-

миться к использовании сетки в виде правильных многоугольников 

(квадрат, куб), приемлемым являются элементы с отношением сторон к 

1:4. 

Необходимо помнить, что МКЭ – приближенный метод, точность 

которого зависит от правильного выбора типов и размеров конечных 

элементов. Так, например, более частая сетка требуется там, где ожидает-

ся большой градиент деформаций или напряжений. В то же время более 

редкая сетка может применяться в зонах с более или менее постоянными 

деформациями или напряжениями, а также в областях не представляю-

щих особого интереса [14]. 

Точность результатов анализа уменьшается, если размеры соседних 

элементов вблизи концентраторов напряжений существенно различны. 

Приступая к конечно-элементному анализу, инженер должен пони-

мать: 

- к какой области относится данная задача; 

- какая часть всей конструкции должна исследоваться подробнее; 
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- какое упрощение можно допустить в данной задаче. 

Ошибки могут возникать на различных стадиях конечно-

элементного анализа: при постановке задачи, построении модели, число-

вом решении. 

Ошибки постановки задачи могут возникать, когда выбранный тип 

конечных элементов или их размер не соответствуют физическому пове-

дению материала в конструкции. Источником ошибок также является не-

корректное задание граничных условий. 

Ошибки построения модели возникают при замене реальной кон-

струкции ограниченным числом конечных элементов (с учетом их форм 

и размеров). Solid, shell, beam. 

Тип и количество элементов влияют на точность вычислений. Так, 

например, при вычислении силы, в случае нелинейного анализа, при не-

большом числе конечных элементов их количество существенно влияет 

на величину вычисляемой силы. Однако при увеличении числа элементов 

результаты стабилизируются (рис. 3.2). Также размер элемента суще-

ственно влияет при моделировании процессов разрушения. 

 

 
 

Рис. 3.2. Влияние количества элементов на точность расчета [14] 

 

 

3.2. Способы создания конечно-элементных моделей 

 

1. Создание конечно-элементной модели в программе LS-PREPOST 

- использование произвольной стеки; 

- использование упорядоченной сетки; 
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- создание геометрии с последующим нанесением конечно-

элементной сетки (для сложных моделей); 

- непосредственное создание конечно-элементной сетки (для 

простых моделей). 

2. Импорт КЭМ из других программ hipermresh, ANSA, Nastran и 

др. 

3. Создание k-файла в программе Ansys Mehanical, Ansys Work-

bench или в любой другой программе поддерживающей создание  

     карт ls-dyna. 
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ГЛАВА 4 

 

ОПРЕДЕЛЕНИЕ МОДЕЛЕЙ МАТЕРИАЛА 

 

4.1. Модели материалов в LS-DYNA 

 

В LS-DYNA существует большое количество различных моделей 

металлов, наиболее применимые к процессам металлобработки представ-

лены в таблице 4.1. 

Табл. 4.1 

Модели материалов для процессов металлобработки 

Изотропные пла-

стические 

3, 15, 18, 24, 106 

Твердые (rigid) 20 

Анизотропные пла-

стические 

36, 37 – для листовой штамповки, 39 (с FLD) 

Тепловые T1 

 

 

4.2. Характеристика упруго-пластического материала 

 

Для линейного материала напряжения пропорциональны деформа-

циям, а его поведение описывается законом Гука [15]. Форма закона Гука 

имеет вид: 

 = Е,  (4.1) 

где  - напряжение,   

Е - модуль Юнга,  

 - деформация. 

Упругость представляет собой способность материала сохранять 

исходную форму после снятия нагрузки. Все материалы, поведение кото-

рых подчиняется закону Гука, являются упругими. В неупругом материа-

ле деформации после снятия нагрузки остаются. Наиболее распростра-
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ненным видом неупругого поведение материала, является пластическое 

состояние (описываемое кривой упрочнения). 

В ряде случаев необходима оценка влияния скорости нагружения 

и температуры на поведение материала. Влияние скорости деформаций 

становится существенным для многих металлических материалов при 

высоких температурах. Для некоторых уравнений состояния значимость 

деформаций может существенно меняться в зависимости от скорости. 

При небольших скоростях удара (до 5-10 м/сек) анализ можно проводить 

без учета скорости деформации. 

 

4.2.1. Пластические материалы 

 

Пластические деформации не исчезают после снятия нагрузки и, 

таким образом, являются остаточными. Характерно, что после появления 

пластических деформаций достаточно небольшого увеличения напряже-

ний для существенного роста деформаций. Это явление называется теку-

честью, а соответствующее напряжение называется напряжением текуче-

сти (рис. 4.1). 

 

Рис. 4.1. График напряжение-деформация [15] 

 

Существуют так называемые инженерные напряжения и соответ-

ствующие им инженерные деформации, а также истинные напряжения и 

деформации. Инженерные деформации иногда рассматриваются как «ма-

лые» деформации. В одноосном случае (рис. 4.2) инженерные напряже-

ния и деформации определяются следующим образом: 
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eng = P/A,     (4.2) 

eng = L/L,   (4.3) 

где eng - инженерные напряжения, 

 P - приложенная нагрузка, 

 A - площадь поперечного сече-

ния, 

 eng - инженерные деформации, 

 L - изменение длины, 

L - начальная длина. 

 

Рис. 4.2. Одноосное растяжение об-

разца [15] 

При работе с программой LS-DYNA требуется вводить значения 

напряжений и деформаций в виде истинных напряжений и деформаций. 

Для одномерного случая истинные деформации находятся по формуле: 

true = ln(L/Lo),     (4.4) 

где true - истинные деформации,  

L - текущее значение длины,  

Lo - начальная длина. 

Из этого соотношения видно, почему истинные деформации назы-

ваются логарифмическими. Чтобы перейти от инженерных напряжений и 

деформаций к истинным, можно использовать следующие соотношения: 

true = eng(1 + eng),  (4.5) 

true = ln(1 + eng),  (4.6) 

где true - истинные напряжения. 

При малых деформациях значения инженерных и истинных пара-

метров почти идентичны. Однако по мере возрастания деформаций эти 

значения расходятся.  

Пластичность материала проявляется как его «текучесть». В одно-

мерном случае текучесть возникает при достижении напряжениями вели-

чины предела текучести. Для более сложных напряженных состояний ис-

пользуется энергетический критерий формоизменения, часто называемый 

критерием Мизеса. После достижения начала пластичности напряжения 

должны возрастать, чтобы процесс пластического деформирования раз-

вивался (рис. 4.1). Такое возрастание напряжений называется упрочнени-

ем. 



 28 

Для получения данных о пластичности материала (в простом слу-

чае) используют кривую деформирования после одноосного растяжения 

[16, 17, 18]. 

Рекомендуется провести испытание образца, например, по растяже-

нию и смоделировать данный процесс. Кривые с эксперимента и с моде-

лирования должны совпадать. 

Рекомендуемая последовательность: испытания на стандартный 

механический тест (по ГОСТ 1497-84) → преобразуем в истинную кри-

вую → идентификация параметров моделей материала → закладываем 

параметры в выбранную модель материала → моделируем на стан-

дартный механический тест → проверяем на совпадение результатов 

→ при совпадении результатов используем параметры материала в ра-

бочей модели (при несовпадении проверяем параметры модели материа-

лы). Это особенно актуально при моделировании процессов разрушения. 

 

Виды простых моделей материала: 

 

Рис. 4.3. Виды простых моделей материала: а – упругая модель eE  ; б – упругая 

– идеально пластическая модель; в – упруго-пластическая (билинейная) модель, г - 

упруго-пластическая модель в степенном виде, д- упруго-пластическая кусочно-

линейная модель 
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4.2.2. Испытание на растяжение, сжатие, диаграммы испытаний 

 

Для оценки механических свойств широко используются статиче-

ские испытания, которые проводятся с применением разных схем напря-

женного состояния в образце. К основным разновидностям статических 

испытаний относятся испытания на растяжение, сжатие, изгиб и круче-

ние. 

Испытание на одноосное растяжение – наиболее распространенный 

вид испытаний для оценки свойств металлов и сплавов – сравнительно 

легко подвергаются анализу, позволяют по результатам одного опыта 

определять сразу несколько важных механических характеристик мате-

риалов, являющихся критерием его качества необходимых для конструк-

торских расчетов. 

Методы испытания на растяжение стандартизованы. Имеются от-

дельные стандарты на испытания при комнатной температуре (ГОСТ 

1497-84). 

Для проведения испытаний на растяжение (ГОСТ 1497-84) исполь-

зуются образцы круглого или прямоугольного сечения (рис. 4.4б). Для 

испытания листовых материалов используются плоские образцы (рис. 

4.4в). 

 
Рис. 4.4. Размеры образцов для испытания на растяжения 

 

Наиболее ценные сведения при изучении характера деформируемо-

сти каждого материала можно получить из диаграмм испытания образцов. 

По данным, полученным из опытной диаграммы, строят диаграмму рас-

тяжения. 

Диаграммой растяжения называется график, показывающий функ-

циональную зависимость между нагрузкой и деформацией при статиче-

ском растяжении образца до его разрыва. 
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На рис. 4.5 показан вид диаграммы растяжения малоуглеролистой 

стали в координатах:  

Нагрузка )(tF  = f (абсолютное удлинение )(tl )  

 

 
Рис. 4.6. Диаграмма растяжения пластичного материала 

 

На диаграмме растяжения OABCDEG показаны 7 характерных то-

чек, cоответствующих определенному уровню нагрузки и ограничиваю-

щих 6 различных зон деформирования: 

OA – зона пропорциональности (линейной упругости); 

AB – зона нелинейной упругости; 

BC – зона упругопластических деформаций; 

CD – зона текучести (пластических деформаций); 

DE – зона упрочнения; 

EG – зона закритических деформаций. 

Прямолинейный участок ОА диаграммы соответствует состоянию 

материала образца описываемому законом Гука; наклон прямой ОА к оси 

абсцисс характеризует жесткость материала. В пределах закона Гука тан-

генс угла наклона прямой  lfF   к оси l  определяется величиной E: 

ElFtg  /  
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Точка А соответствует его пределу пропорциональности пц , т.е. 

наибольшему напряжению, до которого материал следует закону Гука, 

которое определяется как отношение силы, при котором эта пропорцио-

нальность еще не нарушается, к начальной площади поперечного сечения 

образца: 

0

пц

пц
A

F
 . 

На участке ОВ материал ведет себя упруго.  

На участке CD, называемом площадкой текучести, происходит зна-

чительное удлинение образца при почти постоянном уровне нагрузки, 

когда 0F . Такое состояние материала называется текучестью. 

Ордината точки C на диаграмме соответствует пределу текучести 

y  материала образца. Под пределом текучести понимается то напряже-

ние при котором происходит рост деформаций без заметного увеличения 

нагрузки и определяется как отношение силы, соответствующей точки С 

к начальной площади поперечного сечения образца 

0

y

y
A

F
 . 

У материалов, не имеющих на диаграмме явно выраженной пло-

щадки текучести, принимают условный предел текучести 2.0y , при кото-

ром остаточное удлинение образца l  достигает 0,2%. 

На участке DE после выхода на поверхность большей части дефек-

тов кристаллической решетки материал самоупрочняется. Указанный 

участок диаграммы называется зоной упрочнения. При подходе к т. Е де-

формации начинают локализоваться в области наиболее слабого сечения, 

где зарождается шейка образца. 

Точка Е на диаграмме характеризует наибольшей ординатой, соот-

ветствующей пределу прочности или временного сопротивления матери-

ала u , т.е. отношению максимальной силы, которую способен выдер-

жать образец, к его начальной площади поперечного сечения 

0A

Fu
u   

На участке EG заканчивается формирование шейки. В точке G про-

исходит разрыв образца. Его размеры восстанавливаются на величину 
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упругой деформации. У многих материалов разрушение происходит без 

заметного образования шейки. Сила, соответствующая точке G, называ-

ется разрушающей силой frF , а напряжение – истинным сопротивлением 

разрыву (истинным пределом прочности).  

Разрушающие напряжение делятся на условные и истинные: 

0A

F frc

fr   - условное; 
1A

F frtr

fr   - истинное, 

где frF - разрушающая нагрузка; 1A  - площадь поперечного сечения 

образца в месте разрыва. 

Так как первоначальная площадь 0A  приблизительно в два раза пре-

вышает площадь разрыва 1A , а разрушающая нагрузка frF  составляет 

приблизительно 80% от наибольшей нагрузки uF , то 

u

c

fr   ; u

tr

fr   . 

Например, для низкоуглеродистой стали Ст3 u = 380 МПа, tr

fr = 

800…1000 МПа. 

Пределы пропорциональности и упругости характеризуют упругие 

свойства материала. Пределы текучести и прочности являются характе-

ристиками прочности материала. Пластичность материала оценивают от-

носительными остаточными деформациями накопленными образцом до 

его разрушения: относительным остаточным удлинением: 

%100
0

01 



l

ll
r ; 

и относительным остаточным сужением   площади сечения образ-

ца при разрыве 

 

%100
0

10 



A

AA
 ; 

где 0l и 0A  - начальная длина и площадь сечения образца; 1l и 1A  - 

длина и площадь сечения образца, измеренные после его разрушения. 

Сложенные части разорванного образца из пластичного материала 

длиннее исходного на величину остаточной деформации. Упругая часть 

деформации при разрушении образца исчезает. 
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Повторное нагружение разгруженного образца позволяет получить 

укороченную диаграмму, являющуюся продолжением начального участ-

ка полной диаграммы. Линия повторного нагружения практически сов-

падает с линией разгрузки. Аналогичная картина наблюдается при раз-

грузке и повторном нагружении образца для любой точки.  

Укороченная диаграмма характерна для образцов, изготовленных из 

материала в результате холодной обработки (ковки, штамповки, вытяжки) 

и получившего деформационное или механическое упрочнение или 

наклеп (упрочнение материала). Модуль упругости материала при этом 

практически не изменится, точки А и В на укороченной диаграмме ока-

жутся намного выше, площадка текучести исчезнет. Это означает, что 

при наклепе повышаются прочностные свойства металла, но снижаются 

свойства пластичности и он станет ближе к хрупким материалам у кото-

рых диаграмма испытания очень короткая, так как образцы разрушаются 

при весьма малых остаточных деформациях [15]. 

Наклеп наблюдается не у всех материалов и металлов, например, 

свинец, олово и др. Явление наклепа широко используется в технике, 

например, упрочнение деталей, подвергая из при изготовлении пластиче-

скому деформированию. 

В зависимости от характеристик пластичности материалы подраз-

деляют на пластичные и хрупкие. К хрупким относят материалы с малым 

относительным остаточным удлинением при разрыве ( ...5%2r ), напри-

мер чугун, бетон, стекло. Диаграмма растяжения хрупких материалов, 

например чугуна, не имеет площадки текучести. Для хрупких материалов 

при испытании на растяжение определяется в основном только пределом 

прочности u . Образец из хрупких материалов разрушаются без образо-

вания шейки и зон сдвига. 

Деление материалов на пластичные и хрупкие вообще условно, так 

как их механические свойства зависят от состояния, обусловленные 

условиями эксплуатации. Пластичные материалы при низких температу-

рах разрушаются хрупко, а хрупкие при высоких давлениях проявляют 

пластичные свойства. 
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Во многих случаях не важно иметь точные данные при утонении, и мы 

можем просто нарисовать прямую от начала образовании шейки до 

точки разрушения. 

 

Пластические свойства металлов (в отличие от упругих свойств) 

можно изменять путем сплавления и термообработки. Так предел текуче-

сти железа подобными методами можно повысить в 50 раз. 

Если первоначально растянуть пластичный материал за предел те-

кучести, а потом разгрузив сжать его, то наблюдается понижение вели-

чины предела текучести. Такое явление, называемое эффектом Баушин-

гера, связано с анизотропным упрочнением, т.е. упрочнением, зависящим 

от направления нагружения. 

Уменьшение предела текучести при сжатии в точности равно пре-

вышению исходного предела текучести при растяжении. Эффект Ба-

ушингера имеет место в металлах при смене знака нагружения. Учет эф-

фекта Баушингера важен при расчетах циклических нагрузок. Имеют ме-

сто два основных типа упрочнения: изотропное и кинематическое. При 

изотропном упрочнении абсолютные величины предела текучести при 

сжатии и растяжения всегда равны. 

 

Параметры В  и   для большинства материалов не являются предель-

ными характеристиками. При В   начинается образовываться шейка. 

У пластичных материалов при растяжении образуется шейка. В мо-

мент начала местного сужения сила достигает своего максимального 

значения и при развитии сосредоточенной деформации убывает. По-

этому у пластичных материалов В  соответствует переходу от равно-

мерной деформации к сосредоточенной. 
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кон/ SFKK   - величина приближения из-за неравномерного распределения 

напряжений в шейке. 

Величина   значительно меньше сосредоточенной Кe  

Истинная деформация разрушения ke  определяется по формуле 













1

1
lnКe  

В случае отсутствия точных данных по данному параметру значе-

ние Кe (для пластичнх металлов) примерно соответствует значению 3 . 

 

Изотропное упрочнение рекомендуется использовать при учете ко-

нечных деформаций (больших истинных деформаций, превосходящих в 

металлах 5-10 %) в случае пропорционального нагружения. Кинематиче-

ское упрочнение следует использовать в случае непропорционального 

или циклического нагружения, когда истинные деформации относитель-

но малы (менее 5-10% для металлов). 

                   

 
Рис. 4.7. Графики упрочнения: а – изотропное, б - кинематическое 

 

При использовании билинейной модели материала величина T  

принимается равной пределу текучести 2,0 , модуль упрочнения рассчи-

тывается по формуле: 
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

 2,0В 
tE  - где   соответствует параметру В .  

Разрушающая (предельная) деформация: 
















1

1
lnпр  

 

Одноосные испытания позволяют получить: 

- предел упругости и текучести, которые характеризуют сопро-

тивление малым пластическим деформациям; 

- предел прочности В  - характеризует сопротивление значитель-

ным пластическим деформациям и разрушению; 

- конечная точка истинной диаграммы K  - характеризует сопро-

тивление разрушению; 

- относительное удлинение образца  , сужение шейки  , которые 

характеризует пластичность. 

 

4.2.3. Обработка экспериментальных данных и построение кри-

вых деформирования для оценки упруго-пластических свойств ма-

териалов [20] 

 

После статистических и динамических испытаний на одноосное 

растяжение получают кривые деформирования. 

В момент начала местного сужения образца сила достигает своего 

максимального значения и при развитии сосредоточенной деформации 

убывает. Поэтому у пластичных металлов В  не характеризует сопротив-

ление разрушению и соответствует лишь моменту перехода от равномер-

ной к сосредоточенной деформации. 

При обработке экспериментальных данных связь между условной 

относительной деформацией 0  и истинной (логарифмической) деформа-

цией   оценивается по соотношению: 

 01ln   , 

где 00 / LL  
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Действительная площадь сечения образца при растяжении опреде-

лялась из условия, что пластическое течение происходит при неизменном 

объеме, тогда  

 00 1   , 

где   - истинное напряжение, 0  - условное напряжение. 

В этом случае зависимость истинного напряжения   от логарифми-

ческой деформации   называется действительной диаграммой деформи-

рования. Для одноосного растяжения истинная диаграмма располагается 

выше инженерной (рис. 4.9). Коэффициент наклона диаграммы на упру-

гом участке при одноосном растяжении равен модулю Юнга. 

 
Рис. 4.9. Диаграмма деформирования при одноосном растяжении: 1 – условная 

кривая деформирования; 2 – действительная кривая деформирования [20] 

 

Определение свойств деформирования материала целесообразно 

проводить путем разделения истинной деформации на упругую и пласти-

ческую составляющие: 

E

x
xpxexpxx


  ,  

Результатом “усадки” упругой деформации (рис 4.10.) является за-

висимость напряжения от пластической деформации (кривая упрочнения). 

Истинные напряжения при одноосном растяжении и пластическая де-

формация эквивалентны соответственно интенсивности напряжений и 

эффективной пластической деформации. 
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Рис. 4.10. Схема “усадки” упругих деформаций, принятая для разработки мо-

дели: 1 – действительная кривая деформирования; 2 – кривая упрочнения 

 

В результате обработки экспериментальных данных при одноосном 

разрыве образца получены следующие данные (рис. 4.11.): 

- инженерная кривая деформирования, определяемая из испытаний; 

- истинная кривая деформирования; 

- кривая упрочнения. Кривая упрочнения задает напряжение теку-

чести как функцию эквивалентной пластической деформации. Эта кривая 

и задается в программе. 

 
Рис. 4.11. Стадия обработки экспериментальных данных при одноосном раз-

рыве образца: 1 – условная кривая деформирования, 2 – действительная кривая де-

формирования; 3 – кривая упрочнения 

 

До критической точки на стадии равномерного деформирования 

образца экспериментальные и расчетные инженерные кривые деформи-

рования совпадают. 

Кривая упрочнения после локализации деформаций определяется 

итерационным путем до совпадения расчетной кривой с экспериментом. 

Кривая упрочнения монотонно возрастает на всем диапазоне деформации 

образца. 
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Из анализа процесса разрушения следует, что в зависимости от 

свойств материала необходимы различные способы нагружения для 

определения всех его механических свойств. 

Для хрупких материалов растяжение является слишком жестким 

нагружением и для определения механических свойств этих материалов в 

пластической области требуются более мягкие испытания (с малым 

участком растягивающих деформаций или вовсе без участка растягива-

ющих напряжений) – сжатие цилиндров является одним их наиболее 

мягких испытаний. 

В результате сжатия цилиндрического образца, по сравнению с од-

ноосным растяжением. Вместо удлинения происходит укорочение, вме-

сто сужения сечения – его увеличение, поэтому естественно, что истин-

ные напряжения при сжатии меньше инженерных. Пределы упругости и 

текучести хорошо совпадают с соответствующими пределами при растя-

жении. Однако переход к разрушению при сжатии принципиально отли-

чается: 

- пластичные материалы не удается разрушить при сжатии, т.к. они 

сплющиваются; 

- у хрупких материалов типа цемента, силикатов и др. разрушение 

при сжатии происходит путем отрыва. 

Тангенс угла наклона диаграммы при сжатии аналогичен испыта-

ниям на растяжение – является модулем упругости материала. 

Кручение образца является одним из важных методом испытания 

металлов в пластической области. Кручение является наиболее надеж-

ным способом измерения сопротивлению срезу. При этом виде испыта-

ний пластическая деформация происходит практически равномерно по 

длине образца, форма которого остается цилиндрической в течении всего 

процесса. 

 

4.2.4. Учет влияния эффекта скорости деформации 

 

Эффекты скорости деформации в моделях материалов могут учи-

тываться с помощью формулы Купера-Саймондса – степенного закона 

зависимости предела текучести от скорости деформации или определе-
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нием семейства кривых упрочнения для каждой скорости деформации. В 

модели Купера-Саймондса динамический предел текучести пересчитыва-

ется из статических значений с коэффициентом 

p

c

1
.

1

















, где с – эталон-

ная скорость эффективной деформации, при которой предел текучести 

удваивается; 
.

  - скорость эффективной деформации. 

Чтобы предотвратить появление паразитного шума, для оценки 

пластической вязкости используют скорость эквивалентной пластической 

деформации вместо скорости эффективной деформации. 

Но наилучший результат возможен, когда для каждой скорости де-

формации вводятся таблицы с данными кривых упрочения полученными 

экспериментально (рис. 4.12.). 

 

 

 

Рис. 4.12. Кривые упрочнения материала от скорости деформации 

 

4.3. Методики идентификации параметров моделей материала 

 

4.3.1. Определение билинейной модели материала 

Исходные данные: 

- предел текучести материала т ; 

- предел временного сопротивления В ; 

- деформация соответствующая временному сопротивленияю B ; 
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- модуль Юнга Е 

 

Определение касательного модуля: 

E
e

E

B

T
t log

Вlog

loglog

В








   (4.7) 

Для расчета используем истинные (логарифимические) параметры 

(см. формулы 4.5-4.6). 

Данные параметры ( т , Еt) используем в моделях материала MAT3 

или MAT24. Данная модель материала является наименее точной из рас-

сматриваемых. Точность еще ниже если учитывается разрушение. 

 

 

4.3.2. Определение упруго-пластической модель материала в 

степенном виде 

Исходные данные – график зависимости )(ef  (после одноосного 

растяжения, в логарифмическом виде) 

Модель материала определяется следующей формулой  

nke  

где n – коэффициент упрочнения, k – коэффициент прочности. 

Параметры (n, k) определяются при максимальном приближении к 

графику о одноосного растяжения, например, при помощи Excel. 

Данные параметры используем в моделе материала MAT18. Эта 

модель материала является достаточно точной для моделирования боль-

шинства процессов холодной ОМД. 

 

4.3.3. Определение упруго-пластической кусочно-линейной мо-

дели 

Исходные данные – график зависимости )(ef  (после одноосного 

растяжения, в логарифмическом виде). 

Данные параметры вводяться напрямую в программу в виде графи-

ка )(ef . 

Данные параметры в виде ссылки на кривую используем в моделе 

материала MAT24. Данная модель материала является наиболее точной 
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для большинства рассматриваемых процессов. Активно применяется в 

краш-тестах 

 

4.3.4. Методика из диссертации Кирсанова [20] 

1. После механического теста у нас есть: 

- напряжение текучести T  

- напряжения прочности В  

- деформация разрушения Кe  

2. Подставляем данные в формулу 

n

B
n

e











 0  

3. Определяем параметр упрочнения n (например, минимизацией 

функции в Excel). 

4. Определяем значения   от деформации e  при значении дефор-

мации от 0 до Кe  

5. Заносим данные значения в модель материала (например, в таб-

личном виде в Mat 24). 

 

4.3.5. Методика расчета полилинейных моделей материала [23]  

с учетом шейкообразования 

1 точка – соответствует пределу текучести 

Т1

Т1








 

 

2 точка – соответствует временному сопротивлению (при пересчете 

в истинные величины) 

 BB

B
B

E




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1ln
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где B - временное сопротивление; 

Е – модель Юнга; 

B  - инженерные деформации, соответствующие временному со-

противлению 
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3 точка – соответствует параметру разрушения 

Вариант определения параметров по геометрическим замерам шей-

ки образца после разрушения. 

Для круглых образцов: 







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12
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
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где Рk – величина нагрузки в момент нагружения; 

r1 – радиус наименьшего поперечного сечения шейки; 

R – радиус кривизны контура шейки в точке наименьшего сопро-

тивления; 

  - параметр отображения сужения шейки. 

 

Использование данной методики для построения аппроксимирую-

щей кривой деформирования соответствующая экспериментальной кри-

вой 

Имеется кривая деформирования материала 

 

 

Преобразуем в кривую напряжение-деформация (инженерный вид) 
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На этой кривой отмечаем 3 основные точки соответствующие: 

- точку текучести; 

- точке временного сопротивления; 

- точке разрушения. 

 

И несколько дополнительных точек (11, 12, 13, 14, 21, 22). 

Определяем значения этих точек в истинном виде в пластической 

области (без упругих деформаций). 

Т11 0    

   BBB   11ln 22  
















1

1
ln3    































R

r
r

Pk

4
1

ln
12

1

3



  

Промежуточные точки 11-14 находим по формуле 

   nnnnn 11111 11ln    

где nn 11 ,  - значения точки в промежутке от T  до В  

Создаем таблицу значений 

1  1  / 11  11  / 12  12  / 13  13  / 14  14  / 2  2  / 21  21  / 3  3  

Эту таблицу значений заносим в программу и используем в MAT24. 
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4.3.6. Методика Рамберга-Осгуда [19, п. 9.8.4.1.2] 

 

Параметры определяются на основе коэффициента Рамберга-

Осгуда (источник DOT/FAA/AR-MMPPS-01 Metallic Materials Properties 

Development (MMPDS). 

 

где f – напряжение 

f02 – предел текучести при 0,2% деформации 

ep – пластическая деформация 

n – параметр Рамберга-Осгуда 

После расчета параметра n определяется величина пластической 

деформации от напряжения (где напряжение равно 
100

i
i





 ) , i=1...100 

 

4.3.7. методика расчета параметров модели материала Джонсо-

на-Кука [21, 22] 

См. ссылки 21,22 

 

 

Семинар 5 Идентификация параметров моделей материала 

 

4.4. Валидация моделей 

 

Для подтверждения адекватности проведенного моделирования 

необходимо проведения валидации, т.е. подтверждение выполненного 

моделирования и практики. Результаты должны повторять с определен-

ной точностью практические результаты. 

Валидацию проводят на тестовых испытаниях, на установках близ-

ких к моделируемому процессу. Например, для валидации процессов вы-

тяжки можно пользоваться пресс Эриксена. Испытание на изгиб – испы-

тание на изгиб на элемент двойной толщины. Краш-тесты – испытание на 

удар. 

Последовательность действий: 
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В начале проводится практическое испытание на тестовом штампе 

(например, Пресс Эриксена), рис. 4.28. Далее проводится моделирование 

этого же процесса. И проводят сравнение результатов. Результаты долж-

ны совпадать. Если результаты не совпадают, то параметры которые бы-

ли применены при моделировании неверные (cчитается что практические 

результаты у нас достоверные). В этом случае корректируем параметры 

моделирования и повторяем моделирование процесса снова. И снова 

сравниваем результаты с практикой. Это делаем до тех пор, пока резуль-

таты не будут сходными с определенной точностью 

Далее мы спользуем полученные при моделировании параметры 

для моделирования основного процесса (модель материала, размер сетки, 

параметры нагружения). Например, процесса вытяжки. 

В качестве испытательного оборудования можно использовать при-

боры с регулируемым давлением. Соответственно результаты практики и 

моделирования должны совпадать. 

Рекомендуется проводить также верификацию и калибровку чис-

ленного моделирования. 

 

 

Рис.4.28. Валидация моделей  
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4.5. Определение упругого материала [28] 

 

4.6.1. *MAT_ELASTIC (№1) 

Линейно-упругая модель материала eE  , где E – модуль Юнга, e 

– деформация. 

Это материал типа 1 – упругий изотропный материал, который ис-

пользуется для балочных, оболочечных и объемных элементов програм-

мы LS-DYNA. 

 

Карта  

Переменная MID RO E PR DA DB K  

Тип I F F F F F F  

По умолчанию нет нет нет нет 0.0 0.0 0.0  

 

Переменная Описание 

MID Идентификатор материала в виде уникального номера 

RO Массовая плотность 

E Модуль Юнга 

PR Коэффициент Пуассона 

 

4.6. Определение упруго-пластического материала [28] 

 

Для определения пластического материала могут использоваться 

различные материалы: 

 

4.6.1. *MAT_PLASTIC_KINEMATIC (№3) 

Модель используется для расчета изотропного и кинематического 

упрочнения пластичных материалов.  

Формат карты 
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Карта 1 

Переменная MID RO E PR SIGY ETAN BETA  

Тип I F F F F F F  

По умолчанию нет нет нет нет нет 0.0 0.0  

Карта 2 

Переменная SRC SRP FS VP     

Тип F F F F     

По умолчанию Не 

исп. 

Не 

исп. 

Не 

исп. 

0.0     

 

Переменная Описание 

MID Идентификатор материала в виде уникального номера 

RO Массовая плотность 

E Модуль Юнга 

PR Коэффициент Пуассона 

SIGY Предел текучести 

ETAN Касательный модуль (рис. 4.29) 

BETA Параметр упрочнения 0 < `  < 1 

SRC Параметр скорости деформации C для модели Купера-

Саймондса 

SRP Параметр скорости деформации P для модели Купера-

Саймондса 

FS Деформация разрушения для разрушаемых элементов 

VP Формулировка эффектов скорости деформации 

 

Для учета влияния скорости деформации используется модель Ку-

пера-Саймондса (Cowper-Symonds), в которой предел текучести умножа-

ется на коэффициент 

P

C

/1
.

1

















 

где   - скорость деформации 

Кинематическое, изотропное или совместное кинематическое и изо-

тропное упрочнение может быть задано с помощью варьирования пара-
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метра `  от 0 до 1. Если параметр `  равен 0 или 1 получаем, соответ-

ственно, кинематическое или изотропное упрочнение. 

 

Рис. 4.29. Упругопластический режим с кинематическим и изотропным 

упрочнением, где l0 и l – длина недеформированного и деформированного образца, 

подвергнутого одноосному растяжению. Et - модуль упрочнения 

 

Данная модель позволяет задать критерий разрушения (FS) на осно-

ве предельной пластической деформации. 

Рекомендуется разрушающую предельную деформацию определять 

по следующей формуле: 
















1

1
lnпр ; 

где  относительное сужение шейки образца. 

 

 

4.6.2. *MAT_JOHNSON_COOK (№15) 

Это материал типа 15. Модель пластичности Джонсона/Кука, зави-

сящая от деформации и температуры, иногда используется в задачах, в 

которых скорости деформации изменяются в большом диапазоне, а адиа-

батический рост температуры из-за нагрева при пластической деформа-

ции вызывает снижение прочности материала. При использовании объ-

емных элементов данная модель нуждается в уравнении состояния. 

Карта 1  

Переменная MID RO G E PR DTF VP  
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Тип I F F F F F F  

По умолчанию нет нет нет нет нет 0.0 0.0  

Карта 2 

Переменная A В N С M TM TR EPSO 

Тип F F F F F F F F 

По умолчанию нет 0.0 0.0 0.0 нет нет нет нет 

Карта 3 

Переменная CP PC SPAL IT D1 D2 D3 D4 

Тип F F F F F F F F 

По умолчанию нет 0.0 2.0 0.0 0.0 0.0 0.0 0.0 

 

Карта 4 

Переменная D5        

Тип F        

По умолчанию 0.0        

 

Переменная Описание 

MID Идентификатор материала 

RO Массовая плотность 

G Модуль сдвига 

E Модуль Юнга 

PR Коэффициент Пуассона 

DTF Минимальный размер шага по времени для автомати-

ческого удаления элементов (оболочечных элементов) 

VP Формулировка с учетом эффектов скорости деформа-

ций 

A, В, N, C, M См. уравнения ниже 

TM Температура плавления 

TR Комнатная температура 

EPSO Эффективная скорость пластической деформации 

CP Удельная теплоемкость 

SPALL Тип откола 
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 = 0 по умолчанию принимается значение параметра 2.0 

 = 1 minpp   

 = 2 minmax p  элемент откалывается, при этом никогда 

не допускается растяжение, когда p < 0 

 = 3 minpp   элемент откалывается, при этом никогда не 

допускается растяжение, когда p < 0 

IT Опция итераций по пластической деформации 

D1-D5 Параметры разрушения, см. уравнения ниже 

 

Выражение Джонсона-Кука для напряжения текучести имеет вид: 

 

где A, B, C, n и m - входные константы 

 - эффективная пластическая деформация, 

 - скорость эффективной пластической деформации, для 

 

T
*
 - гомологическая температура,  

 

Константы для разных материалов представлены в работе [21]. 

Деформация при разрушении задается соотношением 

 

где  * - отношение давления к эффективному напряжению 

 

Разрушение происходит, когда параметр повреждения достигает 

значения 1. 
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4.6.3. *MAT_POWER_LAW_PLASTICITY (№18) 

Модель изотропной пластичности с упрочнение по степенному за-

кону (с наличием зависимости от скорости деформации).  

Карта 1  

Переменная MID RO E PR K N SRC SRP 

Тип I F F F F F F F 

По умолчанию нет нет нет нет нет нет 0.0 0.0 

Карта 2  

Переменная SIGY VP       

Тип F F       
По умолчанию 0.0 0.0       

 

Переменная Описание 

MID Идентификатор материала 

RO Массовая плотность 

E Модуль Юнга 

PR Коэффициент Пуассона 

K Коэффициент прочности 

N Экспонента упрочнения 

SRC Параметр скорости деформации C 

SRP Параметр скорости деформации P 

SIGY Дополнительный входной параметр для задания 

начального предела текучести y . В общем случае 

этот параметр необязателен, а предел текучести рас-

считывается, как описано ниже: 

<0.02 SIGYуп   

>0.02 см. ниже 

VP Формулировка зависимости от скорости деформации: 

=0.0: пересчет предела текучести (по умолчанию); 

=1.0: упругопластическая формулировка. 
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Данная модель описывает упругопластическое поведение материала 

с изотропным упрочнением. Предел текучести y  есть функция пласти-

ческой деформации, и подчиняется уравнению: 

 

где εyp - упругая деформация, соответствующая пределу текучести, 

а 
_
p  - эффективная пластическая деформация (логарифмическая). Если 

параметр SIGY задан равным нулю, то деформация, соответствующая 

пределу текучести, определяется приравниванием правых частей уравне-

ния линейного нагружения и уравнения деформационного упрочнения: 

 

что дает упругую деформацию в пределе текучести в виде соотношения: 

 

Если предел текучести SIGY не равна нулю и больше 0.02, то ис-

пользуется формула: 

 

Скорость деформации учитывается с помощью модели Купера и 

Саймондса, в которой напряжение текучести умножается на коэффици-

ент 

 

где 
.

  - скорость деформации.  

Полностью упругопластическая формулировка является дополни-

тельной и включает в себя формулировку Купера и Саймондса внутри 

поверхности текучести. Такой расчет требует больше времени, но улуч-

шение результатов может быть значительным.  
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4.6.4. *MAT_PIECEWISE_LINEAR_PLASTICITY (№24) 

 

Кусочно-линейная модель материала позволяет задать упругопла-

стический материал с произвольной зависимостью между напряжением и 

деформацией (и произвольной зависимостью от скорости деформации). 

Кроме того, можно задать критерий разрушения либо на основе пласти-

ческой деформации, либо на основе минимального шага по времени. 

Карта 1 

Переменная MID RO E PR SIGY ETAN FAIL TDEL 

Тип I F F F F F F F 

По умолчанию нет нет нет нет нет 0.0 10E+2

0 

0 

Карта 2 

Переменная С P LCSS LCSR VP    

Тип F F F F F    

По умолчанию 0 0 0 0 0    

Карта 3 

Переменная EPS1 EPS2 EPS3 EPS4 EPS5 EPS6 EPS7 EPS8 

Тип F F F F F F F F 

По умолчанию 0 0 0 0 0 0 0 0 

 

Карта 4 

Переменная ES1 ES2 ES3 ES4 ES5 ES6 ES7 ES8 

Тип F F F F F F F F 

По умолчанию 0 0 0 0 0 0 0 0 

 

Перемен. Описание 

MID Идентификатор материала 

RO Массовая плотность 

E Модуль Юнга 

PR Коэффициент Пуассона 

SIGY Предел текучести 
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ETAN Касательный модуль, который игнорируется, если LCSS > 

0 

FAIL Критерий разрушения: 

<0.0: разрушение определяется с помощью заданной 

пользователем процедуры; 

= 0.0: разрушение не учитывается; 

>0.0: пластическая деформация до разрушения. 

TDEL Минимальный размер шага по времени для автоматиче-

ского исключения элемента из рассмотрения 

С Параметр скорости деформации C (см. формулы ниже) 

P Параметр скорости деформации P (см. формулы ниже) 

LCSS Идентификатор задающей кривой или таблицы. Иденти-

фикатор задающей кривой, определяющей зависимость 

между эффективным напряжением и эффективной пла-

стической деформацией.  

LCSR Идентификатор задающей кривой, определяющей влия-

ние скорости деформации на предел текучести 

VP Формулировка влияния скорости деформации: 

= -1.0: модель Купера-Саймондса, использующая компо-

ненты девиатора тензора скоростей деформации вместо 

полной скорости деформации 

= 0.0: изменение значения предела текучести (по умолча-

нию) 

= 1.0: вязкопластическая формулировка 

EPS1-EPS8 Значения эффективной пластической деформации (если 

задана переменная SIGY, их вводить не обязательно). 

Необходимо задать не менее 2-х значений. Первое значе-

ние должно быть равно нулю в соответствии с началь-

ным пределом текучести. 

ES1-ES8 Значения предела текучести, соответствующие значениям 

переменных EPS1 - EPS8 
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Если определен касательный модуль ETAN, напряженно-

деформированное состояние можно описать с помощью кривой билиней-

ной зависимости между напряжением и деформацией. Вместо нее можно 

задать кривую, с помощью переменных (EPS1,ES1) - (EPS8,ES8); однако 

если недостаточно 8 точек, можно ввести кривую зависимости между эф-

фективным напряжением и эффективной пластической деформацией 

(LCSS). Во всех случаях затраты приблизительно одинаковы. Самый об-

щий подход – это задать таблицу (LCSS) (см. примечания ниже). 

Имеются три возможности для учета влияния скорости деформации. 

I. Влияние скорости деформации можно учесть с помощью модели Ку-

пера-Саймондса (Cowper-Symonds), в которой предел текучести пересчи-

тывается с коэффициентом 

 

где - скорость деформации, . Если VP=-1, вместо скоростей де-

формации берутся компоненты девиатора тензора скоростей деформации. 

Если используется вязкопластическая формулировка, т.е. VP=1.0, и 

SIGY > 0, то динамический предел упругости определяется суммой ста-

тического напряжения  которое обычно вводится задающей кривой, 

и начального предела текучести SIGY, умноженного на коэффициент Ку-

пера-Саймондса: 

 

Здесь учитывается скорость пластической деформации. Если SIGY=0, то 

используется следующее уравнение: 
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где статическое напряжение  должно определяться задающей кри-

вой. Если вязкопластическая формулировка не используется, то всегда 

берется это уравнение. 

 

4.6.5. *MAT_3-PARAMETER_BARLAT (№36) 

 

Это материал типа 36. Модель была разработана Барлатом и Лайэном для 

моделирования анизотропных материалов в условиях плоского напря-

женного состояния. Анизотропию можно задавать с помощью параметров 

Ланкфорда. 

Карта 1  

Переменная MID RO E PR HR PI P2 ITER 

Тип I F F F F F F F 

 

Карта 2 

Переменная M R00 R45 R90 LCID EO SPI  

Тип F F F F I F F  

 

Карта 3 

Перемен. АОРТ        

Тип F        

 

Карта 4 

Перемен.    Al A2 A3   

Тип    F F F   

 

Карта 5 

Перемен. VI V2 V3 Dl D2 D3 BETA  

Тип F F F F F F F  

 

Перемен. Описание 

MID Идентификатор материала 

RO Массовая плотность 
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E Модуль Юнга E 

PR Коэффициент Пуассона v 

HR Закон упрочнения: 

= 1.0: линейный (по умолчанию) 

= 2.0: экспоненциальный 

= 3.0: вводится задающей кривой 

P1 Параметр материала: 

HR = 1.0: касательный модуль 

HR = 2.0: k – коэффициент прочности для экспоненциаль-

ного закона упрочнения 

P2 Параметр материала: 

HR = 1.0: предел прочности 

HR = 2.0: экспоненциальный коэффициент n 

ITER Ограничение по количеству итераций для ускорения расче-

та 

M m – экспонента поверхности текучести Барлата 

R00 R00 – параметр Ланкфорда, определяемый в эксперименте 

R45 R45 – параметр Ланкфорда, определяемый в эксперименте 

R90 R90 – параметр Ланкфорда, определяемый в эксперименте 

LCID Идентификатор задающей кривой для закона упрочнения 

(HR=3) 

EO 
0 - значение деформации для определения начального 

предела текучести для экспоненциального закона упроч-

нения (по умолчанию = 0.0) 

SPI spi, если Е0 = 0 (по умолчанию = 0.0) 

= 0.0: е0=(Е/k)**[1/(п-1)] 

<0.02: е0 = spi 

> 0.02: е0=(spi/k)**[1/(п-1)] 

АОРТ Оси материала 

=0.0: локально ортотропный материал с осями, заданными 

узлами 1, 2 и 4 в элементе (см. *DEFINE_ 

COORDINATE_NODES) 

=2.0: глобально ортотропный материал, оси в котором 
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определяются векторами, описанными в замечаниях ниже 

(аналогично заданию по ключевому слову 

*DEFINE_COORDINATE_VECTOR) 

=3.0: локально ортотропный материал, оси в котором за-

даются поворотом осей в материале вокруг нормали эле-

мента на угол BETA с линией в плоскости элемента, опре-

деленной произведением вектора v и нормали элемента 

XP YP ZP Координаты точки p для AOPT = 1 

A1 A2 A3 Компоненты вектора a для AOPT = 2 

VI V2 V3 Компоненты вектора v для AOPT = 3 

D1 D2 D3 Компоненты вектора d для AOPT = 2 

BETA Угол BETA в градусах для AOPT = 3; может быть заменен 

значением, заданным при определении элементов, см. 

*ELEMENT_SHELL_BETA 

 

Критерий текучести Ф для плоского напряженного состояния в слу-

чае анизотропии определяется формулой: 

 

где σY - предел текучести, а Ki=1,2 задаются соотношениями 

 

Константы анизотропного материала a, c, h, p выражаются через па-

раметры R00, R45 и R90: 

 

Параметр анизотропии р вычисляется неявно. В соответствии с мо-

делью Барлата и Лайэна значение R - отношение деформаций по ширине 
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к деформациям по толщине - для произвольного угла ф можно рассчитать 

по формуле: 

 

где   - одноосное напряжение при растяжении в направлении  . Это 

выражение можно использовать для получения значения р с помощью 

итераций. Пусть  =45°. Определим функцию g в виде: 

 

Значение р находится с помощью итераций. 

Для материалов с гранецентрированной кубической структурой рекомен-

дуется использовать m=8. Для материалов с объемноцентрированной ку-

бической структурой можно использовать m=6. Предел текучести можно 

выразить через k и n: 

 

где εyp - упругая деформация, соответствующая пределу текучести, а 
_
p  - 

эффективная пластическая деформация (логарифмическая). Если SIGY=0, 

деформация, соответствующая пределу текучести, находится как общее 

решение уравнения линейно упругого нагружения и уравнения упрочне-

ния деформации 

 

что дает упругую деформацию, соответствующую пределу текучести в 

виде: 

 

Если SIGY≠0 и больше 0.02, то: 
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       4.6.6. *MAT_TRANSVERSELY_ANISOTROPIC_ELASTIC_ 

PLASTIC (№37) 

Это материал типа 37, предназначен для моделирования поведения 

анизотропных материалов в процессе листовой штамповки. В модели 

учитывается только поперечная анизотропия. Дополнительно можно ис-

пользовать задающую кривую, определяющую произвольную зависи-

мость между напряжением и эффективной пластической деформацией. 

Эта модель пластичности является итерационной и может использоваться 

только для оболочечных элементов.  

Карта 1  

Переменная MID RO E PR SIGY ETAN R HLCI

D Тип I F F F F F F F 

 

Перемен. Описание 

MID Идентификатор материала 

RO Массовая плотность 

E Модуль Юнга 

PR Коэффициент Пуассона 

SIGY Предел текучести 

ETAN Модуль пластического упрочнения 

R Параметр анизотропного упрочнения 

HLCID Идентификатор задающей кривой, определяющей зависи-

мость между эффективным пределом текучести и эффек-

тивной пластической деформацией 

 

Рассмотрим декартову систему координат, оси которой параллельны 

трем плоскостям симметрии в случае анизотропного поведения. Для них 

функция текучести, предложенная Хиллом [21], может быть записана в 

виде: 
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где 1y , 2y , 3y  - пределы текучести при растяжении, а 12y , 23y , 31y  пределы 

текучести при сдвиге. Константы F, G H, L, М, N связаны с пределом те-

кучести формулами: 

 

Если положить  и   

получим модель пластичности Мизеса для изотропного случая. 

Для случая поперечной анизотропии, когда в плоскости x1-x2 свойства не 

меняются, справедливы следующие соотношения: 

 

полученные в предположении, что 1y = 2y = y  

Если положить  то критерий текучести принимает вид: 

 

где  

Вектор скорости пластической деформации направлен по нормали к по-

верхности текучести, и тогда  находится по формуле: 
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Теперь рассмотрим случай плоского напряженного состояния, при кото-

ром 33  = 0. Определим входной параметр анизотропии R, как отношение 

скоростей пластических деформаций в плоскости и из плоскости 

 

Из этого следует, что 

 

В предположении плоского напряженного состояния и с использованием 

полученной формулы для R, функцию текучести можно записать в сле-

дующем виде: 

 

Необходимо отметить несколько отличий этой модели от других 

моделей пластичности для оболочечных элементов, таких как, например, 

MAT_PIECEWISE_LINEAR_PLASTICITY. Во-первых, функция текуче-

сти для плоского напряженного состояния не содержит компонентов по-

перечного сдвигового напряжения, которые пересчитываются с учетом 

упругости, и, во-вторых, эта модель всегда является полностью итераци-

онной. Следовательно, можно ожидать, что результаты, полученные для 

изотропного случая, когда R=1.0, и результаты другой изотропной моде-

ли будут отличаться, но обычно эти отличия несущественны 

 

4.6.7. *MAT_ELASTIC_VISCOPLASTIC_THERMAL (№106) 

 

Упруговязкопластическая модель материала с учетом тепловых эф-

фектов. Позволяет задавать различные величины параметров в зависимо-

сти от температуры. 

Карта 1  

Переменная MID RO E PR SIGY ALPHA LCSS  

Тип I F F F F F F  
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Карта 2  

Переменная QR1 CR1 QR2 CR2 QX1 CXI QX2 CX2 

Тип F F F F F F F F 

 

Карта 3  

Переменная VK VM LCE LCPR LC 

SIGY 

LCR LCX LC 

ALPH 
Тип F F F F F F F F 

 

Перемен. Описание 

MID Идентификатор материала 

RO Массовая плотность 

E Модуль Юнга 

PR Коэффициент Пуассона 

SIGY Начальный предел текучести 

LCSS Идентификатор задающей кривой. Кривая определяет эф-

фективную пластическую деформацию в зависимости от 

эффективного напряжения. При применении этой опции 

карта 2 игнорируется. 

ALPHA Коэффициент теплового расширения 

QR1 Параметр изотропного упрочнения Qr1 

CR1 Параметр изотропного упрочнения Cr1 

QR2 Параметр изотропного упрочнения Qr2 

CR2 Параметр изотропного упрочнения Cr2 

QX1 Параметр кинематического упрочнения Qχ1 

CXI Параметр кинематического упрочнения Cχ1 

QX2 Параметр кинематического упрочнения Qχ2 

CX2 Параметр кинематического упрочнения Cχ2 

VK Параметр вязкого материала Vk 

VM Параметр вязкого материала Vm 

LCE Задающая кривая, определяющая модуль Юнга в виде 
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функции температуры. Переменная E на карте 1 игнори-

руется при использовании этой опции. 

LCPR Задающая кривая, определяющая коэффициент Пуассона в 

виде функции температуры. Переменная PR на карте 1 иг-

норируется при использовании этой опции. 

LCSIGY Задающая кривая, определяющая начальный предел теку-

чести в виде функции температуры. Переменная SIGY на 

карте 1 игнорируется при использовании этой опции. 

LCR Задающая кривая для пересчета параметров изотропного 

упрочнения QR1 и QR2 или напряжения, определяемого 

задающей кривой LCSS в виде функции температуры. 

LCX Задающая кривая для пересчета параметров изотропного 

упрочнения QX1 и QX2 в виде функции температуры. 

LCALPH Задающая кривая, определяющая коэффициент теплового 

расширения в виде функции температуры. ALPHA на кар-

те 1 игнорируется при использовании этой опции. 

 

Одноосная кривая напряжения-деформации имеет вид: 

 

Скорость деформации учитывается моделью Купера-Саймондса, в 

которой предел текучести пересчитывается с помощью следующего ко-

эффициента: 

 

Чтобы использовать это соотношение, для вязкоупругих констант Vk и Vm 

задаются следующие значения: 
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4.7. Определение твердого материала 

 

4.7.1. *MAT_RIGID (№20) 

 

Части модели из этого материала считаются принадлежащими жесткому 

телу. Можно присоединить поверхность типа VDA, чтобы моделировать гео-

метрию, например, для оснастки в приложениях по листовой штамповке ме-

талла. Кроме того, можно дополнительно задать глобальные и локальные 

ограничения на центр масс. 

Карта 1  

Переменная MID RO E PR N COUPL

E 

M ALIAS 

Тип I F F F F F F C 

Умолчание нет нет нет нет 0 0 0 пусто 

Карта 2 

Переменная CMO CON1 CON2      

Тип F F F      

Умолчание 0 0 0      

 

Формат дополнительной карты для выходного потока (Должна присут-

ствовать, но может быть оставлена пустой). 

Карта 3 

Переменная LCO или 

A1 

A2 A3 VI V2 V3   

Тип F F F F F F   

Умолчание 0 0 0 0 0 0   

 

Перемен. Описание 

MID Идентификатор материала 

RO Массовая плотность 

E Модуль Юнга 

PR Коэффициент Пуассона 

N Флаг-признак связи с модулем MADYMO3D (не CAL3D), 

переменная n 

COUPLE Опция связывания 

м Флаг-признак связи с модулем MADYMO/CAL3D 
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ALIAS Другое имя поверхности типа VDA 

смо Опция ограничения на центр масс CMO: 

=1.0: ограничения накладываются в глобальных направ-

лениях,  

= 0.0: нет ограничений, 

= -1.0: ограничения накладываются в локальных направ-

лениях (ограничение одноточечного типа SPC). 

CON1 Первый параметр ограничения: 

Если CMO=+1.0, то задается глобальное ограничение 

на поступательное движение: 

=0: нет ограничений, 

=1: ограничение на перемещение по оси x, 

=2: ограничение на перемещение по оси y, 

=3: ограничение на перемещение по оси z, 

=4: ограничение на перемещение по осям x и y, 

=5: ограничение на перемещение по осям y и z, 

=6: ограничение на перемещение по осям z и x, 

=7: ограничение на перемещение по осям x, y и z. 

Если CM0=-1.0, то задается идентификатор локальной си-

стемы координат. См. *DEFINE_ 

COORDINATE_OPTION: Данная координатная система 

фиксирована во времени 

CON2 Второй параметр ограничения: 

Если CMO=+1.0, то задается глобальное ограничение на 

вращательное движение: 

=0: нет ограничений, (далее аналогично) 

Если CM0=-1.0, то задается локальное одноточечное огра-

ничение (SPC) 

=000000 нет ограничений (далее аналогично), 

LCO Номер локальной системы координат для выходного по-

тока данных. См.*DEFINE_ COORDINATE_OPTION. 

A1-V3 Задаются два вектора a и v, фиксированных на жестком 

теле, которые используются для подпрограмм вывода и 
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пользовательских датчиков для подушек безопасности. 

 

Жесткий материал типа 20 является удобным средством превраще-

ния одной или более частей модели, состоящих из балочных, оболочеч-

ных или объемных элементов, в жесткое тело. Аппроксимация деформи-

руемого тела жестким телом – это один из предпочтительных способов 

моделирования во многих реальных приложениях. Например, в задачах 

формовки листового металла оснастка может быть точно и корректно 

представлена как жесткое тело. На ранних этапах проектирования систем 

безопасности можно также считать жестким тело пассажира. При обра-

ботке элементов жесткие элементы пропускаются, при этом не выделяет-

ся память для хранения значений переменных во времени; следовательно, 

использование жесткого материала очень эффективно. 

Модуль Юнга, E и коэффициент Пуассона используются для опре-

деления параметров границы скольжения, если жесткое тело участвует в 

задании контакта. Для таких констант следует задавать реалистичные 

значения, так как нереалистичные значения могут усугубить численные 

проблемы при обработке контактного взаимодействия. 

Направления ограничений, накладываемых на жесткие материалы 

(параметр CMO равен +1 или -1), фиксированы, то есть не изменяются во 

времени. Чтобы накладывать на жесткое тело ограничение, направление 

которого изменялось бы при вращении жесткого тела, используется клю-

чевое слово *BOUNDARY_PRESCRIBED_MOTION_RIGID_LOCAL. 

 

4.8. Определение тепловых моделей материала [28] 

 

*MAT_THERMAL 

С помощью карт *MAT_THERMAL_ можно задавать теплофизиче-

ские параметры материалов при совместном прочность/тепло анализе и 

при чисто тепловом анализе (см. *CONTROL_SOLUTION). Теплофизи-

ческие параметры должны задаваться для всех объемных и оболочечных 
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элементов. Для балочных или дискретных элементов такие параметры 

задавать не нужно, т. к. эти элементы не учитываются на тепловой стадии 

расчета. Однако теплофизические параметры манекена будут присут-

ствовать для этих элементов в файле D3HSP. 

На теплофизические свойства ссылаются с помощью идентифици-

рующего номера TMID, который никак не связан с номерами других ма-

териалов MID, заданными в других картах *MAT_…. В одном расчете 

номера TMID и MID могут совпадать. Эти номера (TMID и MID) связаны 

через карту *PART. 

 

*MAT_THERMAL_ISOTROPIC 

Это материал с теплофизическими свойствами типа 1. Модель позволяет 

задавать изотропные теплофизические свойства материала. 

 

Карта 1  

Переменная TMID TRO TGRLC TGMULT     

Тип I F F F     

 

Карта 2 

Переменная HC TC       

Тип F F       

 

Перемен. Описание 

TMID Идентификатор материала 

TRO Плотность материала: 

= 0.0: по умолчанию используется плотность конструкци-

онного материала 

TGRLC Номер задающей кривой для скорости теплообразования 

(см. *DEFINE_CURVE): 

> 0: функция от времени, 

= 0: используется постоянный коэффициент TGMULT, 

< 0: функция от температуры 

TGMULT Коэффициент скорости теплообразования: 
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= 0.0: теплообразования нет 

HC Теплоемкость 

TC Теплопроводность 

 

 

4.9. Модели накопления повреждения и разрушение материала 

 

Модели разрушения в Лагранжевом методе основаны на удалении 

элемента из расчета при достижении определенного установленного пре-

дельного параметра. 

Варианты определения предельных параметров разрушения: 

- предельный параметр по деформации – MAT3; 

- различные предельные параметры при разрушении (давления, 

главное напряжение, эквивалентные напряжения, главная деформация, 

деформация сдвига и т.п.) – MAT_EROSION; 

- накопление повреждения с последующим разрушением – MAT15; 

- сложные модели разрушения – MAT123, Gurson Mat120, модель 

Gissmo и др. 

При значительных пластических деформациях до разрушения ре-

комендуется использовать параметры разрушения по деформации. 

При малых пластических деформациях до разрушения (хрупкий ма-

териал) рекомендуется использовать критерий по главным напряжениям. 

Данные модели применяются при разделительных процессах ОМД, 

механообработке и при любых других процессах сопровождающиеся 

разрушением. 

В некоторых материалах, например, Mat 3, Mat 15 параметры раз-

рушения задаются непосредственно в карте материала. 

 

4.9.1. *MAT_ADD_EROSION 

Опция ADD_EROSION позволяет ввести разрушение в эти модели, 

хотя эта опция может быть использована в моделях материала с другим 

критерием разрушения/разрыва. Каждый из введенных здесь критериев 

применяется независимо, и как только какой-то из них выполняется, эле-

мент исключается из расчета. 



 71 

 

Карта 1  

Переменная MID EXCL       

Тип I F       

По умолчанию нет нет       

 

Карта 2 

Переменная PFAI

L 

SIGP1 SIGV

M 

EPSP

1 

EPSSH SIGTH IMPULS

E 

 

Тип F F F F F F F  

По умолчанию нет нет нет нет нет нет нет  

 

Перемен. Описание 

MID Идентификатор материала, для которого задается крите-

рий разрушения 

EXCL Номер исключения. Если какие-то константы разрушения 

полагаются равными этому числу, то будет происходить 

обход соответствующих критериев разрушения (что сни-

жает затраты на применение модели материала с разру-

шением). Например, чтобы исключить растяжение како-

го-то материала, в качестве значения этой переменной 

пользователь должен задать какое-то необычное число, 

например, 1234, задать Pmin равным 0.0, а все остальные 

константы равными 1234. По умолчанию значение этого 

пара метра равно 0.0, что исключает из рассмотрения все 

критерии, в которых константы заданы равными 0.0 или 

оставлены пробелами при вводе 

PFAIL Давление разрушения Pmin 

SIGP1 Главное напряжение при разрушении σmax 

SIGVM Эквивалентное напряжение при разрушении max

_

  

EPSP1 Главная деформация при разрушении εmax 

EPSSH Деформация сдвига при разрушении γmax 

SIGTH Пороговое напряжение σ0 

IMPULS Разрушающий импульс напряжений Kf 
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E 

 

 

Критерии разрушения: 

1.  где Р – давление (положительное при сжатии), Pmin – давле-

ние разрушения 

2. , где σ1 – максимальное главное напряжение, σmax – главное 

напряжение при разрушении 

3. , где `

ij  - компоненты девиатора тензора напря-

жений, max

_

  - эквивалентное напряжение при разрушении. 

4. , где ε1 – максимальная главная деформация, εmax – главная де-

формация при разрушении. 

5. , где γ1 – сдвиговая деформация, γmax – сдвиговая деформация 

при разрушении 

6. Критерий Тулера-Бучера 

 

где σ1 – максимальное главное напряжение, σ0 – заданное пороговое 

напряжение,  Kf – разрушающий импульс напряжений. Напря-

жения, значения которых ниже заданных пороговых, слишком малы, 

чтобы вызвать разрушение даже в результате очень длительного нагру-

жения. 

Использование параметров разрушения GISSMO в данной карте 

позволяет учесть многокомпонентное напряженное состояние и задать 

сложное разрушение материала (в данном методическом пособии не опи-

сано). 

 

4.9.2. *MAT_MODIFIED_PIECEWISE_LINEAR_PLASTICITY 

Это тип материала 123. Можно задать упругопластический матери-

ал с произвольной зависимостью «напряжение-деформация» и произ-

вольной зависимостью от скорости деформации. Данная модель материа-

ла аналогична модели MAT_PIECEWISE_LINEAR_PLASTICITY, но в 
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ней отсутствует набор критериев разрушения. Разрушение происходит 

при достижении значения эффективной пластической деформации, пла-

стического утонения, величины основной компоненты главной плоской 

деформации или минимального шага по времени. 

В данной карте присутствует опция “RATE” для учета зависимости 

скорости пластического разрушения. Опция “RTCL” используется для 

активации RTCL разрушения. 

Карта 5 требуется, если только активна опция RATE или RTCL 

Карта 5 

Переменная LCTSR

F I 

EPSO TRIAX      

Тип F F F      

 

Пере-

мен. 

Описание 

____ ____________ 

LCTSR Кривая нагрузки, которая определяет thinning деформацию 

разрушения в зависимости от скорости пластической де-

формации 

EPSO EPS0 параметр для RTCL разрушения. 

=0: (по умолчанию) RTCL разрушение не активно; 

>0: RTCL разрушение активно 

TRIAX RTCL разрушение трехосный предел. 

=0: (по умолчанию) нет ограничений 

>0: Повреждения не накапливаются когда трехосность пре-

вышает TRIAX. 

 

Опция RTCL разрушения используется для разрушения элемента, 

когда функция разрушения превышает 1. В течении каждого цикла реше-

ния, если приращение пластической деформации больше нуля, прираще-

ние RTCL разрушения вычисляется как: 

 

где 
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и 

0  - одноосное напряжение слома / критическое напряжение разрушения 

Н  - гидростатическое напряжение 

_

  - эффективное напряжение 
p

d


  - приращение эффективной пластической деформации 

Приращения суммируются в течении времени и элемент удаляется 

когда 1damagef . Для 10  damagef , сила элемента не будет ухудшена. 

Значение damagef  сохранена в переменной истории #9 и может быть показа-

на через d3plot файлы, если число дополнительных переменных истории 

≥ 9 в карте *DATABASE_EXTENT_BINARY. 

Дополнительный параметр TRIAX может использоваться, чтобы 

предотвратить чрезмерный рост повреждений RTCL и эрозию элементов для 

элементов плохой формы, которые могли бы показать нереалистично высо-

кие значения для трехосности (triaxiality). Трехосность 


 H хранится в пе-

ременной истории #11. 

Параметр EPSMAJ по сравнению с основными главными деформа-

циями в следующих смыслах: 

• Для оболочек это максимальное собственное значение тензора в 

плоскости деформации, которое увеличивается приращением деформа-

ции. 

• Для объемных элементов она рассчитывается как максимальное 

собственное значение к логарифмическому тензору деформаций 

 

где F – глобальный градиент деформации. В сумме оба типа эле-

мента используют естественную меру деформации для определения раз-
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рушения главные деформации, вычисленные таким образом, выводятся в 

истории переменной #7. 

Чтобы получить представление о вероятности разрушения индика-

тор D рассчитается внутри: 

 

и сохраняется в истории переменной #10. D в диапазоне от 0 (без измене-

ний) до 1 (разрушение). 
p

 , 3 , I  - текущие значения эффективной пла-

стической деформации, деформации утонения (thinning) и главной в 

плоскости деформации. 

 

4.9.3. Модель разрушения GISSMO 

Данная модель разрушения включается в карте 

*MAT_ADD_EROSION и позволяет учесть такие параметры как: 

- деформацию разрушения в зависимости от напряженного состоя-

ния (триаксилити) и параметра Лоде; 

- регуляризационную кривую, которая позволяет обеспечивать 

адекватное удаление элемента независимо от его размера; 

- накопление повреждения с учетом разрушения. 

Поскольку данная модель сложна, в данном пособии она подробна 

не представлена. 
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ГЛАВА 5 

 

ОПРЕДЕЛЕНИЕ ТИПОВ ЭЛЕМЕНТОВ 

 

5.1. Обзор существующих типов элементов 

 

Для процессов деформирования и разрушения твердых тел исполь-

зуются полноинтегрированные элементы и с одноточечным интегрирова-

нием [28]. Элементы низкого порядка (с одноточечным интегрировани-

ем), используемые в LS-DYNA просты, эффективны и точны. Примеры 

конечных элементов представлены на рис. 5.1. 

 
Рис. 5.1. Конечные элементы программы LS-DYNA [28] 

 

Тип элемента характеризуется такими параметрами как формули-

ровка конечного элемента, правило интегрирования, толщина элемента в 

узле и свойства поперечного сечения. 

Типы элементов применяемые при металлообработке: 
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*SECTION_SOLID – карта предназначена для определения свойств 

поперечного сечения для объемных элементов. 

*SECTION_SHELL – карта предназначена для определения свойств 

поперечного сечения для оболочечных элементов 

 

5.2. Объемный элемент [28] 

 

Объемные (Solid) элементы – 3-х мерные конечные элементы, кото-

рые могут моделировать твердые тела и структуру без упрощения гео-

метрии: 

- не требуется никаких геометрических, конструктивных и других 

допущений; 

- граничные условия обрабатываются более реалистично (по срав-

нению с shell или beam); 

- конечно-элементая сетка выглядит как физическая система. 

Минусы: 

- дополнительное время на подготовку сетки; 

- долгое время расчета; 

- низкая производительность для тонкостенных конструкций (про-

блемы заклинивания). 

 

5.2.1. Объемные шестигранные элементы [24] 

 

Наиболее применяемые формулировки solid элементов 

ELFORM = 1 

- пониженное интегрирование; 

- эффективный и точный; 

- работает даже при больших де-

формациях; 

- необходим контроль искажения 

“hourglass”. 
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ELFORM = 2 

- полное интегрирование; 

- медленнее чем ELFORM = 1; 

- слишком жесткий во многих слу-

чаях (особенного при плохих про-

порциях, блокировка сдвига); 

- более нестабилен при больших 

деформациях. 

 

 

 

Рекомендации: 

- использовать формулировку с пониженным интегрированием №1 

(по умолчанию) с определением контроля искажения hourglass; 

- при сильных искажениях solid элементов использовать полноинте-

грированную формулировку №2; 

- при плохих пропорциях solid элементов использовать формули-

ровки -1/-2 

 

5.2.2. Объемные тетраэдральные элементы [24] 

 

ELFORM = 13 

- напряжение в одной точке с узловым сред-

ним давлением; 

- смягченное объемное заклинивание; 

- лучшая производительность чем 

ELFORM=10 если  >0 (металлы, резины) 

- реализована для материалов (1, 3, 6, 24, 27, 

77, 81, 82, 91 ,92 ,106, 120, 123, 124, 128, 129, 

181 ,183, 224, 225, 244). 

В этом элементе предотвращается объемное 

заклинивание путем определения узловых 

объемов и оценивая средние узловые давле-

ния в этих объемах. 

Можно использовать в явных динамических 
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задачах с почти несжимаемым материалом 

(резина, упруго-пластические металлы и т.п.) 

 

5.2.3. *SECTION_SOLID 

Карта предназначена для определения свойств поперечного сечения 

для объемных элементов сплошной среды. 

ELFORM – формулировка элемента 

 

5.3. Оболочечный элемент [25] 

 

5.3.1. Обзор shell формулировок 

 

Часто в конструкции изделия используются тонколистовые детали. 

Например, кузов автомобиля. Для моделирования обшивки, элементов 

кузова и других тонколистовых конструкций используются shell элемен-

ты 

 

 
 

Рис. 5.2. Создание shell элементов [25] 

 

При исследовании операций листовой штамповки, гибки вытяжки, 

где изменение толщины минимально, shell элементы более адекватно и 

правильно моделируют данный процесс. К примеру, получение складок 

на листовых деталях, проявление которых на shell элементов гораздо 

проще, реалистичнее и правильнее чем на solid элементах. Т.е. shell эле-
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менты применяют там где это физически обосновано и соответствует ре-

альному процессу или объекту. 

 

 
 

Рис. 5.3. Реалистичное деформирование shell элемента [25] 

 

 

 

Рис. 5.4. Solid элемент → средняя поверхность в характерной плоскости → 

shell элемент  [25] 

 

Belytschko-Tsay shell формулировка 

ELFORM = 2 (по умолчанию) 

- очень эффективна; 

- интегрирование в 1 точке; 

- билинейная узловая интерполяция; 

- необходим контроль hourglass; 

- жесткость при изгибе (параметр 

BWC в карте *Control_shell); 

- имеет вращательную формулировку; 

- не применяется при ударе; 

- не используется в грубых сетках. 

 

 

Полностью интегрированный shell  
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ELFORM = 16 

- интегрирование 2х2; 

- билинейная узловая интерполяция; 

- не нужен контроль hourglass (введе-

на поправка на поперечное сдвиговое 

усилие); 

- hourglass типа 8 добавляет жест-

кость при изгибе (может улучшить 

конвергенцию); 

- наименее дорого из полноинтегри-

рованных (2х2) элементов; 

- в 2-3 раза дольше чем Belytschko-

Tsay; 

- рекомендуется для неявного анали-

за. 

 

 

 

Интегрирование по толщине 

 

 

Рис. 5.5. Интегрирование по толщине [25] 

 

Возможность изменения толщины оболочек (ISTUPD из карты 

*Control_shell) 

ISTUPD=1 - Деформации вызывают изменение толщины в элемен-

тах оболочки. Вариант важен при формовании листового металла 
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Жесткость при изгибе для Belytschko-Tsay shell (BWC из карты 

*Control_shell) 

BWC=1 - добавлена жесткость при изгибе 

 

Обновление напряжений (OSU) и Нумерация инвариантных узлов 

(INN) 

OSU=1 – включает обновление напряжений 

INN=3(4) – включает нумерация инвариантных узлов 

 

 

5.3.2. *SECTION_SHELL 

 

Карта предназначена для определения свойств поперечного сечения для 

оболочечных элементов. 

ELFORM - формулировка элементов; 

SHRF - корректирующий коэффициент сдвига, устанавливаем зна-

чение 0,83333; 

NIP - число точек интегрирования по толщине; 

T – толщина оболочеченого элемента. 

 

5.3.3. Интегрирование элемента 

 

Для повышения эффективности и снижения вычислительных затрат 

в LS-DYNA преимущественно используются элементы первого порядка с 

одноточечной схемой интегрирования по объему. Такая схема менее чув-

ствительна к изменению начальной геометрии элемента, что является не-

маловажным в процессах с большими деформациями. Недостатком одно-

точечной схемы интегрирования является возможность проявления нефи-

зичных деформационных мод с нулевой энергией (Hourglass modes). 

Программа содержит алгоритмы автоматического контроля и ограниче-

ния Hourglass modes, которые следует активизировать при использовании 

одноточечной схемы [28]. 
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Одноточечное интегрирование означает, что все параметры (давле-

ние, плотность, внутренняя энергия) внутри конечного элемента посто-

янны. Смещения, скорости и ускорения определяются в узлах. На основе 

билинейной аппроксимации скоростей внутри четырехугольного элемен-

та определяются градиенты скоростей, по ним находятся изменение 

плотности и внутренней энергии на следующем временном такте для 

каждого элемента. Далее определяется давление, по которому однознач-

но определяются узловые силы в каждом элементе, затем узловые уско-

рения по которым находятся новые значения скоростей и смещений для 

следующего временного шага. 

Полноинтегрированные элементы, означает, что параметры рассчи-

тываются в узлах. 

За число точек интегрирования по толщине для оболоченного эле-

мента отвечает пункт NIP в карте *SECTION_SHELL. 

Для любой формулировки оболочечного элемента может быть ука-

зано необходимое число точек интегрирования по толщине. Для упругого 

материала достаточно 2 точек (это значение по умолчанию), для матери-

ала, учитывающего пластичность – 5 точек и более.  

Оболочечные элементы это 3D элементы, находящиеся в плоско-

напряженном состоянии. Поэтому программа рассчитывает так, чтобы 

его составляющая, нормальная к серединной поверхности элемента, рав-

нялась нулю. Точки интегрирования, как по плоскости, так и по толщине 

элемента располагаются по определенным правилам. На рис. 5.6. показан 

оболочечный элемент, имеющий одну точку интегрирования по плоско-

сти (использующий редуцированное интегрирование) и несколько точек 

интегрирования по толщине. 



 84 

 
 

Рис. 5.6. Точки интегрирования [28] 

 

 

5.4. Искажения Hourglass 

 

Несмотря на надежность при больших деформациях и расширенные 

возможности экономии суммарного компьютерного времени, solid и shell 

элементы с единственной интегрированной точкой (сокращенные), кото-

рые используются в LS-DYNA, склонны к искажению. Эти искажения, 

обычно называемые hourglassing, имеют колебательную природу и стре-

мят иметь периоды значительно короче чем в случае общего структурно-

го ответа (то есть, в результате получаются математические значения, ко-

торые физически невозможны). 

В типичном случае они не сохраняют жесткость, что приводит к 

появлению зигзагообразной сетки известной как деформации hourglass. 

Появление hourglassing деформаций в процессе анализа может исказить 

результаты, и обязательно должны быть сведены к минимуму [28]. 

 

Рис. 5.8. Не деформированная и деформированная сетка с эффектом hourglass [28] 
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 Для предотвращения искажения hourglassing используется контроль ис-

кажения. 

 

5.4.1. *HOURGLASS 

 

Карта предназначена для подавления искажений формы элементов 

под воздействием искажения hourglass: 

IHQ – тип контроля искажения;  

QM – параметр контроля искажения. 

 

В задачах деформирования твердых тел используется контроль по 

жесткости (IHQ) №4 (5), параметр QM=0,03-0,1. 

Подавление искажений формы элемента введением вязкости реко-

мендуется в расчетах деформирования при высоких скоростях. Подавле-

ние искажений введением жесткости является предпочтительным при бо-

лее низких скоростях, особенно если число шагов решения велико. 

Правильные методы моделирования в значительной степени 

предотвращают деформации hourglass. Основные принципы - это исполь-

зование, однородной сетки, избегая концентрации нагрузок в единствен-

ной точке. Проявившись в одном элементе, hourglassing передается со-

седним, все точечные нагрузки распространяются на области нескольких, 

соседних узлов. В целом, упорядочивание общей сетки почти всегда зна-

чительно уменьшает эффект hourglassing. 

Одним из методов управления hourglass деформациями является ре-

гулирование вязкости материала модели (model's bulk viscosity), исполь-

зуя карту *CONTROL_BULK_VISCOSITY. 

Другое, обычно более приемлемое решение hourglassing проблем - 

использование полностью встроенной формулировки (fully integrated 

formulations) для оболоченных и объемных элементов. Эта элементная 

формулировка никогда не испытает hourglass деформаций. Однако, эти 

опции требуют больших затрат процессорного времени, чем другие эле-

ментные формулировки, и могут привести к излишней жесткости (блоки-

ровке) параметров модели, что, в ряде случае, делает невозможным мо-
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делирование таких процессов как обработка давлением, формообразова-

ние, и скручивание. Блокировка исправлена в оболоченных элементах за 

счет использования предполагаемых областей напряжения. 

При выполнении динамического анализа с сокращенными интегри-

рованными элементами, всегда важно определить насколько hourglass 

эффекты повлияли на полученные результаты. Так, общее основное пра-

вило - hourglass энергия не должна превышать 10% внутренней энергии 

(internal energy). Hourglass энергию можно сравнить с внутренней энерги-

ей при просмотре ASCII файлов GLSTAT и MATSUM. Чтобы быть уве-

ренным, что результаты hourglass энергии будут отражены в этих файлах, 

в поле HGEN карты *CONTROL_ENERGY должно быть установлено 

значение 1. 
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ГЛАВА 6 

 

ОПРЕДЕЛЕНИЕ НАГРУЖЕНИЯ И ГРАНИЧНЫХ УСЛОВИЙ 

 

6.1. Определение нагружения [28] 

 

После построения модели к ней необходимо приложить нагрузки, 

для этого необходимо определить график изменения нагрузки во времени. 

Для определения нагрузки предварительно должны быть определе-

ны части (*PART) или наборы узлов (*SET_NODE). 

 

6.1.1. *BOUNDARY_PRESCRIBED_MOTION 

 

Карта предназначена для определения для части, узла или набора уз-

лов параметров движения (скорости, ускорения или смещения). Движение 

также можно задавать для твердых тел.  

В карте определяются следующие параметры: 

DOF – определение степени свободы по которой определяется движе-

ние,  

VAD – определение перемещения/скорость/ускорения,  

LCID – график движения,  

SF – коэффициент масштабирования. 

 

6.1.2. *LOAD_BODY_ 

 

Карта предназначена для определения объемных сил, обусловленных 

действием заданного ускорения или угловой скорости.  

В карте определяются следующие параметры: 

LCID – идентификатор задающей кривой; 

SF – коэффициент масштабирования. 

 

6.1.3. *DEFINE_CURVE 
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Карта определяет график изменения нагрузки во времени, A1 – дан-

ные по оси X (время), O1 - данные по оси Y (значения параметра). 

График движения можно задать через функцию используя карту 

*Define_curve_function. 

 

 

6.2. Определение начальной скорости 
 

6.2.1. *INITIAL_VELOCITY_GENERATION 

 

Карта предназначена для определения начальной линейной скорости 

в узлах с помощью идентификаторов узловых наборов. 

В карте определяются следующие параметры: 

VX, VY, VZ – значения начальной скорости по осям,  

XC, YC, ZC – координаты оси вращения,  

NX, NY, NZ – направляющие косинусы по осям. 

 С помощью карты *INITIAL_VELOCITY_RIGID_BODY можно опре-

делять начальную скорость твердых тел. 

 

 

6.3. Определение узловых наборов 

 

Карта *SET_NODE позволяет определять наборы узлов. 
 

 

6.4. Типы ограничений [28] 

 

Перед началом процесса получения решения, нужно приложить к 

модели необходимые ограничения. 

Варианты определения ограничений: 

1. *BOUNDARY_SPC; 

2. *CONSTRAINED_GLOBAL. 

Карта *BOUNDARY_SPC позволяет задавать одноточечные огра-

ничения для узловых точек. 
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Ограничения накладывается в параметре DOF (1-ограничение есть, 

0 – ограничения нет). 

Данное ограничение нельзя применять к узлам принадлежащим 

твердым телам и в расчетах на адвекцию, поскольку идентификаторы уз-

лов могут изменяться во время адаптивного этапа. 

В этом случае используют карту *CONSTRAINED_GLOBAL. 

Карта *CONSTRAINED_GLOBAL позволяет задавать глобальную 

плоскость граничных условий-ограничений. 

Параметры ограничения вводятся в параметрах ТС (поступательное 

движение) и RC (вращательное движение). 

Узлы в пределах допуска (который зависит от размера сетки) при-

вязаны к глобальной плоскости. 

 

6.5. Демпфирование 
 

Демпфирование применяется для минимизации нереалистических 

бесконечных колебаний конструкции, возникших после приложения 

кратковременных нагрузок [28]. 

Карта *DAMPING_GLOBAL позволяет задавать узловое демпфи-

рование (затухание), взвешенное по массе. 

Демпфирование определяется параметром VALDMP. Вектор уси-

лий, обусловленный демпфированием, определяется следующей форму-

лой: 

mDF s

n

damp   

Наилучшее значение для постоянной демпфирования обычно выби-

рается на основе критического коэффициента демпфирования для низшей 

частоты системы, представляющей интерес. Поэтому рекомендуется 

принимать значение 

min2sD  

при этом min  собственная частота, в радианах за единицу времени 

(пример расчета в книге [1], стр.85). 

Энергия, рассеиваемая при демпфировании, взвешенной по массе, 

хранится как энергия демпфирования системы в файле GLSTAT формата 

ASCII. 
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Карта *DAMPING_GLOBAL_STIFFNESS позволяет задавать коэф-

фициент затухания Релея посредством идентификации части. 

Рекомендованные значения 0,01-0,25.  

Матрица демпфирования задается соотношением 

KМС   , 

В общем случае демпфирование, пропорциональное жесткости, яв-

ляется эффективным для высоких частот и действует в направлении, ор-

тогональном к перемещению твердого тела. Демпфирование, пропорцио-

нальное массе, наиболее эффективно для низких частот и препятствует 

движению твердого тела. 

Энергия, рассеиваемая при релеевском демпфировании, вычисляет-

ся только в том случае, когда флаг-признак RYLEN в контрольной карте 

*CONTROL_ENERGY задан равным 2. Эта энергия аккумулируется, как 

внутренняя энергия элемента, и включается в баланс энергии. В файле 

GLSTAT эта энергия суммируется с внутренней энергией. 

Таким образом, В ls-dyna имеется два варианта демпфирования: 

 - демпфирование (узловое демпфирование, взвешенное по массе) 

эффективно гасит низкие частоты, для его определения необходимо вы-

брать все части. 

 - демпфирование применяется для каждой части отдельно и эф-

фективно гасит высокие частоты. 

 

 

 

 

 

 

 

 

 

 

 

 

 



 91 

ГЛАВА 7 

 

ОПРЕДЕНИЕ КОНТАКТНОГО ВЗАИМОДЕЙСТВИЯ 

 

7.1. Алгоритмы контактного взаимодействия 

 

Контактное взаимодействие является неотъемлемой частью многих 

задач с большими деформациями.  

В LS-DYNA, контакт определяется идентификацией (через части, 

компоненты, наборы компонентов, и/или наборы узлов). Расположение 

проверяется в отношении проникновения slave (подчиненной) части че-

рез master (главную) часть. Поиск проникновений, с использованием раз-

личных алгоритмов, производится на каждом шаге расчета. В случае кон-

такта, основанного на штрафе (penalty-based contact), усилия сопротивле-

ния проникновению пропорциональны глубине проникновения, так, что 

они, в конце концов, устраняют это проникновение. Другой контакт ос-

нован на ограничении (constrained-based contact). Твердые тела могут 

быть включены в любой контакт, основанный на штрафе. Для реалистич-

ного распределения контактных усилий рекомендуется, чтобы сетка на 

твердом теле была такой же точной, как и сетка деформируемого тела 

[28].  

Иногда удобно и эффективно определение одиночного контакта 

(single) в модели.  

Рекомендуется избегать определения избыточных контактов. 

а б 

 

Рис. 7.1. Механика работы контакта штрафного типа: а – до проникновения, б 

– после проникновения, создание выталкивающего усилия kF ii   
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7.2. Типы контактов для процессов металлобработки 

 

Автоматический тип контакта в LS-DYNA определяется опцией 

AUTOMATIC в команде *CONTACT [28].  

Для описания контакта при деформировании может применяться 

один из следующих контактов: 

 *CONTACT_AUTOMATIC_ SURFACE _TO_SURFACE; 

 *CONTACT_AUTOMATIC_NODES_TO_SURFACE. 

Для штамповки листовых металлов (тип элемента shell), рекомен-

дуется специальные формующие контакты: 

 *CONTACT_FORMING_ SURFACE _TO_SURFACE; 

 *CONTACT_FORMING_ONE_WAY_SURFACE_TO_SURFACE. 

При формующем контакте ориентация автоматическая. В общем 

случае опция ONE_WAY_SURFACE_TO_SURFACE рекомендуется, ко-

гда проникновение мастер узлов через подчиненную поверхность приме-

няется при адаптивном перестроении сетки. 

Карты *CONTACT_ERODING_SURFACE_TO_SURFACE и 

*CONTACT ERODING_NODES_TO_SURFACE применяются при кон-

такте с разрушением элементов (например, в разделительных процессах 

ОМД) и имеют дополнительные 3 опции ISYM, EROSOP, IADJ, настраи-

вающий данный контакт. 

Основные параметры для карты контакта: 

SSID, MSID – номера подчиненный и главной части/набора;  

SSTYP, MSTYP – тип контактной области (часть, набор части/узлов 

и др.);  

FS – статический коэффициент трения,  

FD – динамический коэффициент трения,  

VC – коэффициент вязкого трения, является необходимым для 

ограничения максимума силы трения; 

VDC – коэффициент демпфирования контакта. 
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ГЛАВА 8 

 

НАСТРОЙКА ПАРАМЕТРОВ РАСЧЕТА 

 

8.1. Шаг интегрирования 

 

Шаг интегрирования рассчитывается автоматически (ранее в главе 

1). Для изменения временного шага используется карта *CONTROL_ 

TIMESTEP и параметр DT2MS (со значением “минус”). 

Для многих задач металлобработки можно увеличивать величину 

временного шага в 5-10 раз. Разница при использовании масштабирова-

нии временного шага заключается в появлении осциллирующих воздей-

ствий и возможной потерей контакта.  

 

*CONTROL_TIMESTEP 

В карте определяются следующие параметры: 

TSSFAC - коэффициент пересчета для исходного шага по времени; 

DT2MS – величина временного шага. 

 

8.2. Настройка параметров решателя 

 

Настройка параметров включает в себя определение контрольных 

карт, сохранения выходных данных и т.п. 

 

8.2.1. Контрольные карты 

 

*CONTROL_ENERGY Карта предназначена для обеспечения управ-

ляющих параметров для учета энергии. 

*CONTROL_SOLUTION Карта предназначена для определения типа 

анализа (структурный, тепловой) 

*CONTROL_ 

TERMINATION 

Карта предназначена для установки времени 

завершения расчета 

*CONTROL_TIMESTEP Карта предназначена для определения вре-
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менного шага 

CONTROL_CONTACY Карта предназначена для определения до-

полнительных параметров контакта 

*CONTROL_SHELL Карта предназначена для определения до-

полнительных параметров оболочечных эле-

ментов 

*CONTROL_ THERMAL_ 

NONLINEAR; 

*CONTROL_ THERMAL_ 

SOLVER; 

*CONTROL_ THERMAL_ 

TIMESTEP 

Контрольные карты для настройки тепловых 

параметров процесса 

 

*CONTROL_ENERGY 

Карта предназначена для обеспечения управляющих параметров 

для опций учета энергии. 

В карте определяются следующие параметры: 

HGEN - опция сохранения энергии искажений элементов по типу 

песочных часов 

RWEN - опция сохранения диссипации энергии 

SLNTEN - опция сохранения энергии по границе скольжения кон-

тактов 

RYLEN - Опция сохранения рассеяния энергии с учетом затухания 

 

*CONTROL_SOLUTION 

Карта предназначена для определения процедуры выполнения ана-

лиза, если выполняется только тепловой или связанный тепловой анализ. 

В карте определяются следующие параметры: 

SOLN – выбор прочностного/теплового расчета 

 

*CONTROL_TERMINATION 

Карта предназначена для завершения выполнения задания. 

В карте определяются следующие параметры: 

ENDTIM – время завершения расчета 
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8.2.2. Карты вывода 

 

*DATABASE_ASCII_OPTION 

Опции этой команды включают следующие файлы в формате ASCII: 

GLSTAT Глобальные данные, энергия всей модели 

MATSUM Энергия частей модели 

RCFORC Данные о усилиях на поверхности раздела 

SECFORC Усилия в поперечном сечении. 

SLEOUT Энергия на поверхности скольжения двух материалов. 

SPCFORC Усилия реакции для одноточечного ограничения (SPC) 

 

*DATABASE_BINARY_OPTION 

Опции этого ключевого слова определяют выходные данные: 

D3DUMP Файлы рестарта, сохранение всей базы данных. Частота 

вывода задается в циклах 

D3PLOT Файла сохранения результатов рпсчета 

INTFOR Выходные данные о контактных границах 

 

8.3. Адаптивное разбиение 

 

При решении задач с высокой геометрической нелинейностью не-

редки ситуации, когда деформирование конструкции приводит к замет-

ным искажениям сетки. В результате элементы могут стать слишком вы-

тянутыми, имеющими острые углы или другие дефекты геометрии 

("скручивание" -warping - для оболочечных элементов). Чтобы избежать 

связанных с этим вычислительных проблем, в пакете LS-DYNA исполь-

зуется специальная технология - динамическое перестроение сетки ко-

нечных элементов (remeshing) [7]. 

Основные подходы адаптированного перестроения: 

1. H-адаптивное перестроение для shell элементов; 

2. R-remeshing для solid элементов; 

3. R-remeshing EFG для solid элементов с перестроением по методу 

Галеркина. 
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Рис. 8.1. Перестроение сетки в зоне больших деформаций [7] 

 

Для большинства задач рекомендуется делать начальный анализ без 

адаптивного объединения. Если результаты начального анализа показы-

вают высоко искаженную сетку и если решение кажется неправильным, 

то можно включить адаптивно перестроение. Адаптивное перестроение 

может также использоваться когда анализ ограничивается в LS-DYNA с 

“негативным объемом элемента” ошибкой [7]. 

 

 

 

8.3.1. *CONTROL_ADAPTIVE 

 

Карта предназначена для активизации адаптивного перестроения 

сетки. Части модели, сетка которых перестраивается адаптивно, задают-

ся картой *PART. 

В карте определяются следующие параметры: 

ADPFREQ - промежуток времени между адаптивными перестроени-

ями сетки; 

ADPTOL – величина допуска в градусах (при ADPOPT=1 или 2); 

ADPOPT - опции адаптации; 

MAXLVL - максимальное число уровней измельчения сетки. 
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8.4. Варианты запуска файла на расчет 

 

После того как k-файл получен, его необходимо запустить на расчет.  

Существует несколько методов запуска k-файла: 

I. Через LS-DYNA program maneger; 

II. Запуск при помощи программы k-runner [11]; 

III. При помощи bat-файла; 

IV. Запуск через программу ANSYS APDL Product launcher (при 

наличии лицензии ANSYS). 
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ГЛАВА 9 

 

АНАЛИЗ РЕЗУЛЬТАТОВ В LS-PREPOST [9] 

 

9.1. Визуализация результатов 

 

Постпроцессорная обработка, следующая за стадиями препроцес-

сорной подготовки и получения решения, позволяет обратиться к резуль-

татам решения и интерпретировать их нужным образом, используя набор 

команд и возможности интерфейса. Результаты решения (применительно 

к задачам инженерной механики) включают значения перемещений, 

напряжений, деформаций, энергии и др. Результатом работы программы 

может быть как графическое, так и табличное представление результатов. 

Графическое изображение можно вывести на монитор, преобразовать в 

файлы с различными расширениями (форматы BMP, JPEG и др.). Про-

грамма позволяет  создать анимационные файлы, что позволяет наблю-

дать анимацию процесса. На стадии выполнения решения результаты со-

храняются в базе данных. Кроме того, средства графического отображе-

ния информации включают векторное представление, эпюры по выбран-

ному сечению и др. При векторном представлении используются отрезки 

со стрелками, чтобы показать как абсолютное значение, так и направле-

ние векторной величины, например, вектора перемещения [10]. 

Визуализация результатов осуществляется по иконкам POST → 

Fricomp. 

Основные закладки: 

Stress – глобальные компоненты напряжений; 

Ndv – узловые перемещения, скорости и ускорения; 

Result – результирующие компоненты напряжений; 

Strain – логарифмические компоненты деформации; 

Misc – давление, температура, толщина оболочки, временной шаг, 

параметры lode, triaxiality и др.; 

Infin – бесконечномалые деформации; 

Green – деформации Green-St. Venant; 

Almans – деформация Almans; 
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S.Rate – степень деформации; 

Elastic – упругие деформации; 

FLD – компоненты деформации FLD (forming limit diagram). 

 

9.2. Графики и таблицы 

 

Вывод графиков параметров от времени осуществляется по икон-

кам POST → History. 

Global – энергетические и кинематические данные для полной мо-

дели; 

Part – энергетические и кинематические данные для частей; 

Nodal – кинематические данные (перемещения, скорости, ускорения) 

для узлов; 

Element – данные напряжений и деформаций для элементов; 

 - Value – установить значение элемента мин/max значения; 

 - E-Type – выбрать тип элемента; 

 - E-Axes – глобальные или локальные оси; 

 - Surface – выбрать расположение оболочки через толщину; 

Int Pt – данные напряжений для элементов с интеграцией точек 

данных; 

Scalar – вывод скалярных данных по предварительно определенно-

му компоненту в Fcomp. 

Вывод графиков из выходных файлов ASCII (American standart cоde 

for information interchange) с помощью кнопки POST → ASCII. 

Выводятся данные которые были изначально указаны в картах 

*Database_option. Например, glstat – глобальные данные по энергии си-

стемы, matsum – данные энергии для выбранных частей, rcforc – данные 

по усилиям и т.п. 
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POST → Fricomp POST → History 

 

Рис. 9.1. Меню постпроцессорной обработки (Fricomp, History) 

 

Сохранить данные в виде таблицы позволяют кнопки POST → 

Output. Сохранить табличные данные можно также после создания гра-

фика и используя кнопку SAVE. 

Кнопка POST → XY Plot c расширением main позволяет разделить 

экран на отдельные части. 
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9.3. Секущие плоскости 

 

Для создания секущей плоскости пользуются кнопками Model → 

Section Plane. 

Могут быть выбраны различные опции определения секущей плос-

кости (базовая точка и направление нормали (по умолчанию), определе-

ние плоскости при помощи 3-х узлов, 2 узла и направление определяю-

щей плоскости). 

Секущей плоскостью может быть отсечена часть модели (Off, Clip+, 

Clip-). 

  

POST → ASCII POST → Output 

 

Рис. 9.2. Меню постпроцессорной обработки (ASCII, Output) 
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Еще одной особенностью является возможность строить эпюры на 

shell объектах с помощью опции “Line”. 

Опция “Force” позволяет высчитывать и вычерчивать по сечению 

значения сил, моментов, площадей и др. 

На сечении можно с помощью опции Meas измерять координаты, 

дистанции, углы, радиуса между узлами. 

 
 

POST → XY Plot Model → Section Plane 

 

Рис. 9.3. Меню постпроцессорной обработки (XY Plot, Section Plane) 

 

9.4. Векторные результаты 

 

Создать векторы можно используя кнопки POST → Vector. 
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Векторы можно указать по таким параметрам как: нормали оболо-

чек, перемещение, скорости, ускорение, главные напряжения и др. 

 

9.5. Анимации 

 

Для анимации процесса на нижней панели имеется кнопка Anim. 

Разобраться в работе панели Animate обычно сложности не вызывает. 

Для определения точек отсчета или плоскости для последующей 

анимации пользуются кнопками POST → Follow. 

Для определения пути узла используют кнопки POST → Trace. 

  

POST → Vector POST → Follow 

 

Рис. 9.4. Меню постпроцессорной обработки (Vector, Follow, Trace) 
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POST → Trace 

 

Рис. 9.5. Меню постпроцессорной обработки (Trace) 

 

 

Семинар 6 Вытяжка детали из листовой заготовки с адаптив-

ным перестроением 

Семинар 7 Горячая штамповка (осадка) цилиндрической заго-

товки 

Семинар 8 Прокатка заготовки между цилиндрическими роли-

ками 

Семинар 9 Разделительная операция – процесс резки 
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ГЛАВА 10 

 

РЕКОМЕНДАЦИИ 

 

10.1. Параметры для моделирования процессов ОМД [27] 

 

1. При явном моделировании процесса формообразования время выпол-

нения может быть значительно уменьшено, используя mass scaling и/или 

искусственно высокую скорость инструмента. Оба этих метода вносят 

искусственные динамические эффекты, которые должны быть миними-

зированы. 

2. Рекомендуется выбрать максимальную скорость инструмента 2-5 мет-

ра/сек, начинать и заканчивать моделирование с нулевой скоростью. Мо-

жет использоваться простой профиль трапециевидной скорости как пока-

зано на рисунке. Используйте массовое масштабирование временного 

шага (параметр dt2ms) увеличенный в 10-20 раз. 

 
Рис. 10.1. Трапециевидный график нагружения инструмента 

 

 

Карта *SECTION_SHELL 

1. Для анализа только процесса формообразования, по умолчанию реко-

мендуется тип оболочки #2.  

2. Если будет выполнен анализ упругого пружинения после формования 

рекомендуется более долгий - тип оболочки #16 для обоих операций мо-

делирования. 
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3. Число интеграционных точек по толщине nip также выбирается ис-

пользуя эту карту. Три точки могут быть адекватны для анализа формо-

вания, но если будет выполнен анализ пружинения необходимо исполь-

зовать 5 точек или лучше 7 точек. 

 

Карта *CONTROL_SHELL 

4. Если некоторые треугольные элементы присутсвуют в конечно-

элементой сетки, LS-DYNA автоматически применит более точную C0 

оболочечную треугольную формулировку когда выбран флаг itrist. 

5. Активизируйте изменение толщины оболочечного элемента, используя 

флаг istupd. Иначе элементы останутся постоянной толщины. 

6. Если используете формулировку #2, активизируйте деформирующую 

жесткость используя параметр bwc. 

 

Карта *CONTROL_HOURGLASS 

7. Для металлоформовки рекомендуется контроль искажения Hourglass 

по жесткостному параметру. Выберите ihq или как тип 4 или 5 с пара-

метром QM=0,05-0,1. 

 

Материалы 

8. Несколько моделей материала доступны для неявного пружинения, 

включая типы 1, 3, 18, 24, 36 и 37. 

 

Контакт 

9. Рекомендуется основанное на “Штрафе” (Penalty-based) контактное 

взаимодействие для большинства процессов металлоформовки. 

10. Для моделирования листовой штамповки рекомендуется тип контакта 

“forming-one-way”. 

11. Рекомендуется поверхность, определенная с помощью части ID 

(sstyp=mstyp=3). 

12. Если невозможно создать подобие инструмента, то подобие может 

быть создана используя отрицательную “master” толщину mst. 

 

Карта *CONTROL_CONTACT 
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10. Установите масштабный фактор “penalty” для всех сопряжений 0.010 

используя slsfac. 

11. Активизируйте подобие толщины для листа используя shlthk. 

12. Рекомендуется пренебрегать толщиной в твердых инструментах. 

13. Для моделирования формования рекомендуется установить 20 про-

центов от критического вязкого демпфирования (vdc) для устранения вы-

сокочастотных динамических эффектов. 

 

Карта *BOUNDARY_PRESCRIBED_MOTION _RIGID 

14. Движение инструмента определять используя 

*BOUNDARY_PRESCRIBED_MOTION _RIGID карту 

15. Может быть задана скорость или перемещение. Контроль перемеще-

ния (vad=2) рекомендуется для неявного моделирования формовки, где 

большое время шага, так как управление смещением более точны для пе-

ремещения инструмента. 

16. Движение инструмента (смещение или скорость) должно изменяться 

гладко во времени, начиная и заканчивая с нулевой скоростью. LS-

PREPOST позволяет строить плавные графики. 

17. Нет необходимости включать нулевую скорость “захват времени” в 

конце явного формующего моделирования перед процедурой пружине-

ния. 

 

Адаптирование 

18. Адаптация сетки рекомендуется для автоматического разделения эле-

ментов и создания автоматической сетки в областях высокого искажения. 

19. Избегайте треугольных элементов, особенно в критических областях. 

20. Применяйте 200-400 циклов адаптации за время расчета (интервал 

адаптации adpfreq). Следите чтобы элементы не имели значительного 

деформирования между циклами адаптациями  

21. Адаптивный допуск adptol выбирает допустимое изменение угла. Ре-

комендуется величина 4-20 градусов. 

22. Метод использует измерение этого угла и выбирается используя 

adpopt. Рекомендуется метод 2. 
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21. Максимальный угол усовершенствования выбирается с помощью 

maxlvl. Величины в 3-4 рекомендуются в зависимости от начального 

размера элемента. 

22. Полная сетка может быть очищена на один или более уровней при 

старте моделирования используя параметр ireflg 

23. Рекомендуемый метод однопроходный (adpass=1) с активным look-

forward (adpene > 0.0). Параметр adpene указывает минимально допу-

стимое разделение расстояния перед оценкой искривления инструмента. 

24. Адаптивное усовершенствование level может быть изменено в неко-

торых регионах сетки используя адаптивное определение 

*DEFINE_BOX_ADAPTIVE 

 

Выходная информация 

25. Особенный интерес для металлоформовочных приложений − бинар-

ный график базы данных, включающий данные конечных деформаций, 

которые используются в предельных формовочных диаграммах. Включе-

ние деформаций в базу данных осуществляется используя 

*DATABASE_EXTENT_BINARY флаг strflg. 

26. RCFORC и BNDOUT базы данных часто требуют, чтобы получить ре-

акции сил через поверхность раздела и зазор к заданному движению. 

 

 

10.2. Параметры для моделирования разделительных операции 

ОМД и мехобработки 

 

- использовать объемные конечные элементы для инструмента; 

- использовать по возможности одинаковые сеточные размеры инстру-

мента и заготовки; 

- использовать скорость движения резца до 5 м/сек; 

- использовать сложные модели материала, например, MAT15 – материал 

Джонсона-Кука; 

- использовать контакт ERODING_NODES_TO_SURFASE; 

- установить параметры контакта Eroding: isym, erosop, iadj к 1; 

- создать самоконтакт для контакта отхода с заготовкой; 
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- использовать в зоне предполагаемого разрушения размеры элементов 

меньшей величины; 

- установить параметр d1 равным предельной пластической деформации 

материала (при отсутствии точных данных) для модели Джонсона-Кука; 

- установить параметр sigp1 (главные напряжения разрушения) в 

*MAT_ADD_ERODING для низкопластичных, хрупких материалов; 

- установить меньший параметр контактной жесткости slsfac в 

*Control_contact при нереалистичном удалении элементов; 

- установить больший параметр qm в *Hourglass при значительном иска-

жения элементов по типу HOURGLASS; 

- использовать количество элементов по толщине отхода не менее 3-5; 

- при плохом качестве модели использует методы SPH и SPG. 
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ПРАКТИКА 

Скачать учебные файлы можно с сайта https://dynacrash.ru 

 

Семинар 1. Осадка заготовки в 2D постановке 

 

Создание карт 

Стальная заготовка диаметром 100 мм и высотой 75 мм осаживает-

ся между двумя бойками диаметрами 150 мм и высотой 25 мм при скоро-

сти движения бойков 2 м/с (бойки принимаем абсолютно жесткими) - рис. 

3.1. Определить напряжения и деформации в течение осадки. 

 
Рис. 3.1. Пример задачи 

 

Учитывая осевую симметрию задачи, будем моделировать лишь се-

чение конструкции плоскостью, проходящей через ось симметрии. Рас-

смотрим вначале очень простую модель с малым количеством узлов и 

конечных элементов - для того, чтобы проиллюстрировать все этапы ре-

шения задачи с использованием лишь простейших средств (подготовка 

данных с помощью текстового редактора) [7]. 

https://dynacrash.ru/


 113 

 
 

Рис. 3.2. Упрощенная конечно-элементная модель задачи осадки 

 

Далее приведен пример простого k-файла – процесс осадки цилин-

дрической заготовки 2D. 

Такой текстовый файл может быть подготовлен с помощью любого 

текстового редактора, сохраняющего текст без форматирования (Notepad; 

Wordpad или Word при выборе режима сохранения «Только текст»). Имя 

и расширение файла также могут быть любыми (традиционно для этих 

файлов используется расширение .к - от слова «keywords») [7]. 

Сетка конечных элементов, показанная на рис. 3.2, является очень 

грубой и использована лишь для сокращения размера входного файла. 

Для решения реальной задачи такая сетка непригодна. Для построения 

более мелкой сетки необходимо будет использовать препроцессор, по-

скольку «ручная» подготовка данных о координатах узлов и элементах 
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слишком трудоемка. Как указано выше, текстовый формат входного фай-

ла LS-DYNA позволяет использовать для подготовки данных практиче-

ски любой препроцессор [7]. 

 

ПРИМЕР ПРОСТОГО K-ФАЙЛА – ПРОЦЕСС ОСАДКИ 

ЦИЛИНДРИЧЕСКОЙ ЗАГОТОВКИ 2D 

 

*KEYWORD    Начало кода 

*SECTION_ 

SHELL 

1,14,1,2,1,0,0,1 

0,0,0,0,0,0,0,0 

Определения типа эле-

мента 

*MAT_ 

PLASTIC 

_KINEMATIC  

1,7800,2E11,0.3,250E6,940

E6,1 

0  

Определение модели ма-

териала заготовки 

*MAT_RIGID 2,7800,2E11,0.3 

1,7,7 

0 

Определение модели ма-

териала нижнего бойка 

*MAT_RIGID 3,7800,2E11,0.3 

1,6,7 

0 

Определение модели ма-

териала верхнего бойка 

*PART 

 

BLANK 

1,1,1 

Определение part заго-

товки 

*PART 

 

TOOL_LOW 

2,1,2 

Определение part нижне-

го бойка 

*PART 

 

TOOL_TOP 

3,1,3 

Определение part верхне-

го бойка 

*NODE 

 

1,0,0.025,0 

2,0,0.05,0 

3,0,0.075,0 

4,0,0.1,0 

5,0.025,0.025,0 

6,0.025,0.05,0 

7,0.025,0.075,0 

8,0.025,0.1,0 

9,0.05,0.025,0 

10,0.05,0.05,0 

11,0.05,0.075,0 

12,0.05,0.1,0 

13,0,0,0 

14,0,0.025,0 

15,0.025,0,0 

16,0.025,0.025,0 

17,0.05,0,0 

18,0.05,0.025,0 

Определение координаты 

узлов 
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19,0.075,0,0 

20,0.075,0.025,0 

21,0,0.1,0 

22,0,0.125,0 

23,0.025,0.1,0 

24,0.025,0.125,0 

25,0.05,0.1,0 

26,0.05,0.125,0 

27,0.075,0.1,0 

28,0.075,0.125,0 

*ELEMENT_ 

SHELL 

 

1,1,5,6,2,1 

2,1,6,7,3,2 

3,1,7,8,4,3 

4,1,9,10,6,5 

5,1,10,11,7,6 

6,1,11,12,8,7 

7,2,15,16,14,13 

8,2,17,18,16,15 

9,2,19,20,18,17 

10,3,23,24,22,21 

11,3,25,26,24,23 

12,3,27,28,26,25 

Определение элементов 

(присвоение соответ-

ствующего номера части 

и номера узлов) 

 

*CONTROL_ 

TIMESTEP 

0,0.9 

 

Определение временного 

шага 

*CONTROL_ 

TERMINATION 

2E-2 Определение время 

окончания расчета 

*DATABASE_BI

NARY_ 

D3PLOT 

2E-3 Определение частоты 

вывода результатов рас-

чета 

*SET_PART_ 

LIST 

1 

1 

Создание набора части 

№1 

*SET_PART_ 

LIST 

2 

2 

Создание набора части 

№2 

*SET_PART_ 

LIST 

3 

3 

Создание набора части 

№3 

*DEFINE_ 

CURVE 

1 

0,0 

0.005,-2 

0.03,-2 

Определение графика 

нагружения 

*BOUNDARY_P

RESCRIBED_M

OTION_ 

RIGID 

3,2,0,1,1 Определение движение 

инструмента 
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*CONTACT_ 

2D_ 

AUTOMATIC_S

URFACE_TO_S

URFACE_ID 

1 

1,2,,,0.1 

0 

Определение контакта 

между заготовкой и 

нижним бойком 

*CONTACT_ 

2D_ 

AUTOMATIC_S

URFACE_TO_S

URFACE_ID 

2 

1,3,,,0.1 

0 

Определение контакта 

между заготовкой и 

верхним бойком 

*END  Окончание кода 

 

Файлы: 

расчетная модель - primer6.k 

https://dynacrash.ru/Workshop/Ex1.zip 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://dynacrash.ru/Workshop/Ex1.zip
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Семинар 2. Сеточное моделирование в LS-

PREPOST 

 

Графический интерфейс пользователя LS-PREPOST состоит из сле-

дующих частей: 

 Верхнее раскрывающее меню - данное меню находится вверху окна LS-

PREPOST и содержит пункты для работы с файлами, выбора объектов, 

настройки интерфейса и прочие команды имеющие вспомогательный 

характер. 

 Нижняя панель содержит кнопки быстрого управления отображением 

модели, выбора проекции и др. 

 Правая панель содержит кнопки, соответствующие определенной за-

кладке, для создания геометрии, конечно-элемнтной геометрии, созда-

ния, редактирования модели и т.д. 

 Командная строка. В командной строке можно вводить текстовые ко-

манды LS-PREPOST. 

 Окно сообщений. В нем можно просмотреть порядок ввода команд. 

 

Верхнее раскрывающее меню LS-PREPOST 

Верхнее выпадающее меню содержит команды для управления 

файлами, выбора элементов модели, отображения элементов модели и 

параметров. Оно состоит из следующих пунктов: 

 File - в данном пункте меню содержатся команды для работы с фай-
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лами, такие как сохранение модели в файле, чтение ее из файла, вы-

ход из программы и другие. 

 Misc. - в данном меню содержатся команды, позволяющие отобра-

зить модель относительно плоскости, получить информацию о раз-

мере модели, изменить название модели и пр. 

 View - команды данного меню позволяют выбирать компоненты 

модели, используемые в работе. 

o Background - с помощью команд данного меню можно управ-

лять отображением модели. 

 Geovetry – создание и редактирование геометрии модели. 

 FEM – создание и редактирование конечно-элементной геометрии мо-

дели. 

 Applications - в данном пункте меню содержатся различные прило-

жения с помощью которых можно создавать конктретные модели. 

 Setting – различные настроичные параметры. 

 Help - помощь 

 

Скачать программу можно с сайта  

http://ftp.lstc.com/anonymous/outgoing/lsprepost/4.5/ 

 

Управление моделью в графическом окне используются следующие 

кнопки: 

Вращение: Shift + Левая кнопка мыши 

Перемещение: Shift + Средняя кнопка мыши  

Масштабирование: Shift + Правая кнопка мыши / колесико. 

 

Для настройки панелей:  

- Меню – View – Toolbar – Text and Icon (Right) 

- Меню – View – Toolbar – Text and Icon (Bottom) 

- Меню – View – Toolbar – Toolbar Font – 10 

 

Для настройка окна: 

- Нижняя панель – Option – ISO View (галочка) 

- Нижняя панель – Option – Anim Player (галочка) 

http://ftp.lstc.com/anonymous/outgoing/lsprepost/4.5/
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Учебный видеоурок https://youtu.be/lDH0e9b1Uag 

Построение оболочечных сеточных фигур 

Шаг 1 

Построение оболочечного короба 

Правая панель Mesh → ShapeM → 

Box_Shell 

 

Вводятся координаты начального 

угла PMin X=Y=Z=0.  

Вводятся координаты конечного уг-

ла PMax X=Y=Z=1. 

Вводится величина разбиения сто-

рон короба Vx=10, Vy=10, Vz = 10 

Нажать Create / Accept 

 

 

 

 

 

 

 

 

Шаг 2 

Построение плоскости по 4-м точ-

кам 

Mesh → ShapeM → 4N_Shell 

 

Вводятся координаты четырех то-

чек P1=0,0,0 P2=0,-5,0 P3=-5,-5,0 

P4=-5,0,0 

Указывается число элементов по 

сторонам Nx=Ny=10 

Нажать Create / Accept 

https://youtu.be/lDH0e9b1Uag
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Шаг 3 

Построение сферической оболочки 

Mesh → ShapeM → Sphere_Shell 

 

 

Вводится радиус и плотность раз-

биения. Radius=5, Density=5.  

Вводятся координаты середины 

X=Y=Z=0 

Нажать Create / Accept 

Шаг 4 

Построение оболочечного цилин-

дра 

Mesh → ShapeM → Cilinder_Shell 

 

 
Вводятся радиус, длина, величина 

разбиения, координаты центра ос-

нования цилиндра. Radius=5, 

Length=10, Num Ele=20 Num=5 

Dirx, diry, dirz – направления оси 

цилиндра 

Замечание: 

Дерево панелей вверху слева. 

Можно показать, скрыть, удалить нужные части 
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Шаг 5 

Панель Меню | File – New, далее Yes, далее No 

Построение круга 

Mesh → ShapeM → Circle_Shell 

 

 

 

Вводятся радиус, длина, величина разбиения, угол. Radius=5, Density=20, 

Radiu_In=2, Density_In=26 

Нажать Create / Accept 
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Разбиение исходной или импортированной геометрии 

Шаг 6 

Панель Меню | File – New/Yes/No 

Создать плоскость, правая панель: 

Surf – Plane, нажать Apply, close 

Mesh → AutoM 

Разбиение плоскостей постоянным 

размером 

 

Выбираем Size, указываем Elem 

Size=0.1, выбираем исходную плос-

кую геометрию, Mesh, Accept 

 

 

 

Однако таким способом можно разбивать относительно простую геомет-

рию, для сложной геометрии рекомендуется использовать другую сеточ-

ную программу (Hipermesh, ansys/ls-dyna и др.). 
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Шаг 8 

 Разбиение плоскостей точным разбиением  

Панель Меню | File – New/Yes/No 

Создать плоскость, правая панель: Surf – Plane, нажать Apply, Close 

Mesh → NLineM → 4 Line shell 

 

 

Для исходной плоской геометрии указываем величины разбиения 

N1=N2=N3=N4=10, поочередно указываем граничные линии плоскости 

Нажать Mesh It / Accept / Done 

Данным способом можно более качественно разбить геометрию, но вре-

мени требует значительно больше. 

Необходимо разбивать каждую часть геометрии. 
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Построение объемных сеточных фигур 

Шаг 9 

Построение объемного короба 

Панель Меню | File – New/ Yes/No 

Mesh → ShapeM → Box_Solid 

 

Вводятся координаты начального 

угла PMin X=Y=Z=0.  

Вводятся координаты конечного 

угла PMax X=Y=Z=1. 

Вводится величина разбиения сто-

рон короба Vx=10, Vy=10, Vz = 10 

Нажать Create / Accept 

 

 

 

 

 

 

 

 

 

 

Шаг 10 

Построение объемного шара 

Mesh → ShapeM → Sphere_Solid 

 

 
 

Вводится радиус и плотность раз-

биения. Radius=5, Density=5.  

Вводятся координаты середины 

X=Y=Z=0 

Нажать Create / Accept / Done 
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Шаг 11 

 Построение объемного цилиндра  

Mesh → ShapeM → Cilinder_Solid 

 

 

Вводятся радиус, длина, величина разбиения, координаты центра основа-

ния цилиндра. Radius=1, Length=10, Num Ele=20 Num=5 

Dirx, diry, dirz – направления оси цилиндра 

Нажать Create / Accept / Done 

Замечание: 

Дерево панелей вверху слева. 

Можно показать, скрыть, удалить нужные части 
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Нанесение объемной сетки на исходную или импортированную геомет-

рию 

Шаг 12 

Нанесение сетки на объемную геометрию 

Панель Меню | File – New / Yes/No 

Создать объемное тело, правая панель: Solid – Box, нажать Apply. Close 

Mesh → SolidM 

 

 

Для исходной объемной геометрии указываем Elem Size 

Нажать Try Meshing Automatically / Accept / Done 

Скройте исходную геометрию в дереве панелей. 

Хорошие восьми узловые правильные (кирпичные) элементы строятся 

только на простых фигурах 
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Тетраэдрная сетка (4-х узловые пирамиды) строится на любой твердо-

тельной геометрии. Для их построения в ls-prepost сначала нужно по-

строить оболочечную сетку на всей поверхности твердотельной геомет-

рии 

Шаг 13 

Построение предварительной обо-

лочечной сетки 

Панель Меню | File – New / Yes/No 

Создать объемное тело, правая па-

нель: Solid – Box, нажать Apply, 

Close 

 Mesh → AutoM 

 

Выбираем Size, указываем Elem 

Size=0.1, выбираем поочередно 

плоскости объемной геометрии 

Нажать Mesh / Accept 

Шаг 14 

Построение тетраэдраэдной сетки 

Mesh → TetraM 

 

 

С помощью TetMesh наносим тет-

раэдральную сетку. Указываем на 

оболочечную сетку 

Нажать Tetmesh / Accept / Done 

Сейчас присутствуют две сетки, 

при необходимости сетку на по-

верхности можно удалить 

Скройте исходную сетку в дереве 

панелей. 
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Выполнить следующие задания 
 Создать линию Curve - Line 

 Координаты узлов EleTol - Measur 

 Длина EleTol - Measur 

 Найти узел EleTol - Find 

 Показать узел (элемент) EleTol - Ident 

 Показать нормаль EleTol -Normal 

 Изменить нормаль EleTol -Normal 

 Создать  shell пластину 10х10 Mesh - ShapeM 

 Разделить элементы на 2 части EleTol – DetEle 

 Переместить одну часть относи-

тельно другой 

EleTol - Transf 

 Переместить обратно EleTol - Transf 

 Объединить узлы EleTol - DupNod 

 Создать  shell пластину 10х10 Mesh - ShapeM 

 Создать из нее solid часть Mesh - EleGen 

 Создать  shell пластину 10х10 Mesh - ShapeM 

 Используя окно Entity Greation: 

- ограничения; 

- определение сварных узлов; 

- сохранение истории; 

- нагрузки на сегмент; 

- создание набор узлов, частей, 

сегметов 

Model - CreEnt 

 

https://dynacrash.ru/Workshop/Ex2.zip 

 

 

 

 

 

 

 

https://dynacrash.ru/Workshop/Ex2.zip
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Семинар 3. Осадка заготовки в 3D постановке 

№   

1 Построение  за-

готовки в виде 

объемного куба 

 

Mesh → ShapeM → Box_Solid 

Вводятся координаты начального угла PMin  

X = 20; Y = 20; Z = 2.  

Вводятся координаты конечного угла PMax  

X = 80; Y = 80; Z = 62. 

Вводится величина разбиения сторон короба  

Vx = 5, Vy = 5, Vz = 5 

Нажать Create / Accept 

2 Построение 

нижней плоско-

сти (матрицы) 

по 4-м точкам 

Mesh → ShapeM → 4N_Shell 

Вводятся координаты четырех точек  

P1 = 0,0,0     P2 = 100,0,0   P3 = 100,100,0  P4 = 

0,100,0 

Указывается число элементов по сторонам 

Nx=Ny=10 

Нажать Create / Accept 

3 Построение 

верхней плоско-

сти (пуансона) 

по 4-м точкам 

Mesh → ShapeM → 4N_Shell 

Вводятся координаты четырех точек  

P1 = 0,0,65    P2 = 100,0,65   P3 = 100,100,65  

P4 = 0,100,65 

Указывается число элементов по сторонам 

Nx=Ny=10 

Нажать Create / Accept 

4 Определение 

модели материа-

ла заготовки 

Model → Keywrd → *Mat_plastic_kinematic 

(003) 

R0=7.85e-9, E=2e5, PR=0.3, SIGY=250, ETAN=940 

Нажать Accept / Done 

5 Определение 

модели материа-

ла нижней плос-

кости 

Model → Keywrd → *Mat_rigid (20) 

Нажать New 

R0=7.85e-9, E=2e5, PR=0.3, CM0=1, CON1=7, 

CON2=7 

Нажать Accept  
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6 Определение 

модели материа-

ла верхней плос-

кости 

Model → Keywrd → *Mat_rigid (20) 

Нажать New 

R0=7.85e-9, E=2e5, PR=0.3, CM0=1, CON1=4, 

CON2=7 

Нажать Accept / Done 

7 Определение 

типа элемента 

заготовки 

Model → Keywrd → *Section_solid 

ELFORM=1 

Нажать Accept / Done 

8 Определение 

типа элемента 

плоскостей 

Model → Keywrd → *Section_shell 

T1=T2=T3=T4=1 

Нажать Accept / Done 

9 Определение ча-

сти 1 (заготовка) 

Model → Keywrd → *Part 

Выбрать справа номер 1 

Написать название blank 

Присвоить SECID = 1 MID = 1 

Нажать Accept 

10 Определение ча-

сти 2 (нижняя 

плоскость) - 

матрицы 

Выбрать справа номер 2 

Написать название niz 

Присвоить SECID = 2 MID = 2 

Нажать Accept 

11 Определение ча-

сти 3 (верхняя 

плоскость) - пу-

ансон 

Выбрать справа номер 3 

Написать название verh 

Присвоить SECID = 2 MID = 3 

Нажать Accept / Done 

12 Определение 

графика нагруз-

ки 

Model → Keywrd → *Define_curve  

(A, O) = (0, 0); (0.05, 2000); (1, 2000) 

Использовать “Insert” 

13 Определение 

карты нагруже-

ния (движение 

верхней пласти-

ны)  

Model → Keywrd → *Boundary_ Pre-

scribed_motion_rigid 

PID = 2, DOF = 3, VAD = 0, LCID = 1, SF = -1  

Accept / Done 

14 Определение Model → Keywrd → *Contact_ automat-
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контакта заго-

товка – нижняя 

плоскость 

 

ic_surface_to_surface 

SSTYP = MSTYP = 3, SSID = 1, MSID = 2, FS=0.1 

Accept  

15 Определение 

контакта заго-

товка – верхняя 

плоскость 

Model → Keywrd → *Contact_ automat-

ic_surface_to_surface 

Нажать New 

SSTYP = MSTYP = 3, SSID = 1, MSID = 3, FS=0.1 

Accept / Done 

16 Определение 

время заверше-

ния 

Model → Keywrd → *Control_ termination 

ENDTIM=0.03 

Accept / Done 

17 Определение ча-

стоты записи 

выходных фай-

лов 

Model → Keywrd → *Database_ binary_d3plot 

NPLTC = 5 

Accept / Done 

18 Сохранение на 

расчет 

File → Save 

19 Запуск на расчет Запуск через k-runner 

20 Загрузка файлов 

 

File → Open → LSDYNA binary plot 

Загрузка файлов d3plot 

21 Анимация 

процесса 

Нижнее меню → Anim 

22 Просмотр по 

пластическим 

деформациям 

Post → FriComp → Stress  → Effective plastic 

srtain 

23 Просмотр по 

напряжениям 

Post → FriComp → Stress  → Von Mises stress 

 

Файлы: 

расчетная модель - kub.k 

https://dynacrash.ru/Workshop/Ex3.zip 

 

https://dynacrash.ru/Workshop/Ex3.zip
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Семинар 4. Простая модель ударного взаимодей-

ствия в 3D постановке жестким ударником 

 

 

 

Применяется следующая согласовання система единиц измерения: тонны, 

мм, сек (п.3, таблица 2.1) 

 

№   

1 Построение  за-

готовки в виде 

объемного куба 

 

Mesh → ShapeM → Box_Solid 

Вводятся координаты начального угла PMin  

X = 20; Y = 20; Z = 2.  

Вводятся координаты конечного угла PMax  

X = 80; Y = 80; Z = 62. 

Вводится величина разбиения сторон короба  

Vx = 5, Vy = 5, Vz = 5 

Нажать Create / Accept 

2 Построение 

ударника в виде 

пластины по 4-м 

точкам 

Mesh → ShapeM → 4N_Shell 

Вводятся координаты четырех точек  

P1 = 0,0,65    P2 = 100,0,65   P3 = 100,100,65  

P4 = 0,100,65 

Указывается число элементов по сторонам 
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Nx=Ny=10 

Нажать Create / Accept 

3 Определение 

модели материа-

ла заготовки 

Model → Keywrd → *Mat_plastic_kinematic 

(003) 

R0=7.85e-9, E=2e5, PR=0.3, SIGY=250, ETAN=940 

Нажать Accept / Done 

4 Определение 

модели материа-

ла ударника 

Model → Keywrd → *Mat_rigid (20) 

Нажать New 

R0=7.85e-9, E=2e5, PR=0.3, CM0=1, CON1=4, 

CON2=7 

Нажать Accept / Done 

5 Определение 

типа элемента 

заготовки 

Model → Keywrd → *Section_solid 

ELFORM=1 

Нажать Accept / Done 

6 Определение 

типа элемента 

плоскостей 

Model → Keywrd → *Section_shell 

T1=T2=T3=T4=5 

Нажать Accept / Done 

7 Определение ча-

сти 1 (заготовка) 

Model → Keywrd → *Part 

Выбрать справа номер 1 

Написать название blank 

Присвоить SECID = 1 MID = 1 

Нажать Accept 

8 Определение ча-

сти 2 (ударник) 

Выбрать справа номер 2 

Написать название striker 

Присвоить SECID = 2 MID = 2 

Нажать Accept 

9 Определение 

контакта заго-

товка – ударник 

 

Model → Keywrd → 

*Сontact_automatic_single_surface 

SSTYP = 5 

Accept / Done 

10 Определение 

время заверше-

ния 

Model → Keywrd → *Control_ termination 

ENDTIM=0.0001 

Accept / Done 
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11 Определение ча-

стоты записи 

выходных фай-

лов 

Model → Keywrd → *Database_ binary_d3plot 

NPLTC = 10 

Accept / Done 

12 Определение 

начальной ско-

рости 

Model → Keywrd → *Initial_velocity_generation 

STYP = 2, PID = 2, VZ = -2.5e5 

 

 

13 Закрепляем низ 

заготовки 

Model → CreEnt → Boundary → Spc → Cre 

Указываем узлы по низу заготовки (выбираем Ar-

ea в окне Sel. Nodes). 

Apply / Done 

14 Сохранение на 

расчет 

File → Save → Save keywords 

Вводим название striker.k 

15 Запуск на расчет Запуск через k-runner 

16 Загрузка файлов 

 

File → Open → LSDYNA binary plot 

Загрузка файлов d3plot 

17 Анимация 

процесса 

Нижнее меню → Anim 

18 Просмотр по 

пластическим 

деформациям 

Post → FriComp → Stress  → Effective plastic 

srtain 

19 Просмотр по 

напряжениям 

Post → FriComp → Stress  → Von Mises stress 

20 Просмотр гра-

фика кинетиче-

ской энергии 

Post → Histiry → Clobal → Kinetic Energy 

21 Просмотр ско-

рости движения 

ударника 

Post → Histiry → Nodal → Z-velocity 

Файлы: 

расчетная модель - striker.k 

https://dynacrash.ru/Workshop/Ex4.zip 

https://dynacrash.ru/Workshop/Ex4.zip
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Семинар 5. Идентификация параметров моделей 

материала 

 

4.1. Методика построение кривой )(ef  от исходной кривой растя-

жения )(lfF   

Построить график истинного напряжения от деформации в про-

грамме EXCEL по значениям после одноосного растяжения 

Использовать формулы (4.2-4.6). 

Задать график в моделе материала MAT24 

 

 

4.2. Методика определение параметров для модели материала сте-

пенного вида по кривой одноосного растяжения 

 

1. Имеется график значений после одноосного растяжения металла: 

- график в виде рисунка напряжение от деформации (в инженерном и 

логарифмическом виде) (файл strain_graph.png) 

- табличные значения напряжение от деформации (в инженерном и ло-

гарифмическом виде) (файл DOMEX500MC.xls) 
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- значения в истинных величинах представлен до значения временного 

сопротивления (до момента образования шейки) 

 

2. В Excel строим график зависимости истинных напряжений от де-

формаций: 

  - выбираем значения в 2 столбцах; 

  - строим график – Точечная диаграмма со значениями, соеди-

ненными сглаживающими линиями. 

3. В Excel строим степенную линию тренда 

4. Для линии тренда показываем уравнение на диаграмме (уравнение 

вида 
nke ) 

5. Записываем параметры k и n 

6. Используем выбранные значения k и n в модели материала MAT18 
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4.3. Пример расчета модуля упрочнения (тангенсного модуля) Et 

(ETAN) для модели материала MAT3 и MAT24. 

 

Исходные данные для материала Сталь 3: Предел текучести T =250 

МПа, предел прочности B = 380 МПа, предельная деформация eпр = 30%. 

Переводим в истинные (логарифмические) значения: 

log

В  = eng

В (1 + eng

прe ) = 380(1+0,3)=494 МПа; log

T  ≈ eng

T  = 250 МПа; 

log

прe  = ln(1 + eng

прe ) = ln(1+0,3)=0,26; 

Тангенсный модуль: 

Et = ( log

В  - log

T )/( log

прe ) = (494-250)/0,26 = 940 МПа. 

 

https://dynacrash.ru/Workshop/Ex5.zip 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://dynacrash.ru/Workshop/Ex5.zip
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Семинар 6. Вытяжка детали из листовой заготов-

ки с адаптивным перестроением 

Рассмострим создания адаптивного перестроения shell пластины: 

- штамповка shell пластины без адаптации; 

- штамповка shell пластины с адаптации; 

Пример расчета процесса листовой штамповки - выдавливание шариком 

сферической лунки. 

Учебный видеоурок https://youtu.be/h8hGmHelF_I 

 

Пример расчета процесса листовой штамповки (выдавливание шариком 

сферической лунки) 

 

Модель штамповки сферическим пуансоном представлена заготов-

кой, матрицей, прижимом и пуансоном. Диаметр заготовки 100 мм, тол-

щина 1 мм. Диаметр пуансона 36 мм. Все части модели представлены 

оболочечными элементами. В процессе деформирования сначала прижи-

мается прижим, затем опускается пуансон со скоростью 2 м/сек. Заготов-

ки представлена упругопластической моделью, инструмент твердой мо-

делью. 

 

 

 

 

 

 

https://youtu.be/h8hGmHelF_I
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Шаг 1 

Построение модели заготовки 

 

Заготовка диаметром 100 мм 

Шаг 2 

Построение верхней прижимной 

пластины 

 

Смещение по оси Z на 5 мм 
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Шаг 3 

Построение матрицы 

 

Смещение по оси Z на -5 мм 

Шаг 4 

Построение пуансона 

 

Смещение по оси Z на 25 мм 

Шаг 5 

Определение параметров материала 
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Шаг 6 

Определение модели материала прижима 

 

Разрешить перемещение по Z 

Шаг 7 

Определение модели материала матрицы 
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Шаг 8 

Определение модели материала пуансона 

 

 

Шаг 9 

Определение типа элемента 

 

Толщина оболочки 1 мм 
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Шаг 10 

Определение типа элемента2 

 

 

Шаг 11 

Определение части 1 

 

Заготовка – Part 1 – Элемент Shell 1 – Material 1 

Шаг 12 

Определение части 2 

 

Прижим – Part 2 – Элемент Shell 2 – Material 2 
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Шаг 13 

Определение части 3 

 

Матрица – Part 3 – Элемент Shell 2 – Material 3 

Шаг 14 

Определение части 4 

 

Пуансон – Part 4 – Элемент Shell 2 – Material 4 
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Шаг 15 

Определение контакта 1 

 

Заготовка - прижим 

Шаг 16 

Определение контакта 2 

 

Заготовка – матрица 
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Шаг 17 

Определение контакта 3 

 

Заготовка - пуансон 

Шаг 18 

Определение графика 

 

Определение графика движения пуансона: 

Время = 0; 0.005; 0.02 

Скорость = 0; -2000; -2000 
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Шаг 19 

Определение графика прижима 

 

Определение графика движения прижима: 

Время = 0; 0.005; 0.02 

Перемещение = 0; -7.8; -7.8 

Более правильно на прижим задавать давление. 

 

Шаг 20 

Определение движения на пуансоне 

 

PID 4 – номер части пуансона; 

DOF – движение по оси Z; 

VAD=0 – флаг скорости; 

LCID – кривая нагружения 1. 
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Шаг 21 

Определение движения на прижиме 

 

PID 2 – номер части прижима; 

DOF – движение по оси Z; 

VAD=2 – флаг перемещения; 

LCID – кривая нагружения 2. 

Шаг 22 

Определение времени завершения 

 

 

Шаг 23 

Определение частоты записи выходных данных 
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Шаг 24 

Сохранение результатов 

 

Шаг 25 

Запуск на расчет 

 

 

Шаг 26 

Просмотр результатов по пластиче-

ским деформациям 

 

Шаг 27 

Просмотр результатов по напряже-

ниям 
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Шаг 28 

Просмотр результатов кинетиче-

ской энергии 

 

Шаг 29 

Просмотр деформации для выбран-

ного элемента 

 
 

 

https://dynacrash.ru/Workshop/Ex6.zip 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://dynacrash.ru/Workshop/Ex6.zip
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Семинар 7. Горячая штамповка (осадка) цилин-

дрической заготовки 

Моделирование процесса горячей штамповки (осадка цилиндриче-

ской заготовки). Учебный видеоурок https://youtu.be/9mQL5QjVSz4 

 

Модель горячей осадки представле-

на цилиндрической заготовкой с разме-

рами Ø50х80 и двумя плитами-опорами 

70х70х10. Все части модели задаются 

solid элементами. Используется модель 

материала с учетом тепловых свойств. 

Задается исходная температура 850 С
0
 на 

заготовке. В параметрах контакта учи-

тывается тепловая передача. Нижняя 

опора закреплена. Верхняя опора пере-

мещается со скоростью 2 м/сек. 

Шаг 1 

Создание цилиндрической заготов 

 

Шаг 2 

Создание нижней опоры 

 

https://youtu.be/9mQL5QjVSz4
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Шаг 3 

Создание верхней опоры 

 

 

Шаг 4 

Определение типа элемента 
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Шаг 5 

Определение графика зависимости 1 

 

Модуль Юнга от температуры 

Шаг 6 

Определение графика зависимости 2 

 

Предел текучести от температуры 

Шаг 7 

Принятая система измерения 
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Шаг 8 

Определение материала заготовки 

 

ALPHA – коэффициент линейного теплового расширения 

QR1, CR1 – параметры изотропного упрочнения 

LCE, LCSIGY – номера графиков модуля Юнга и предела текучести со-

ответственно 

Шаг 9 

Определение материала опор 

 

 

Шаг 10 

Определение тепловых свойств 

 

Определяем тепловые параметры заготовки 

HC – теплоемкость 

TC – теплопроводность 
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Шаг 11 

Определение hourglass 

 

 

Шаг 12 

Определяем часть 1 

 

 

Шаг 13 

Определяем часть 2 

 

 

Шаг 14 

Определяем часть 3 
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Шаг 15 

Определяем узловой набор 1 (заготовка) 

 

 

Шаг 16 

Определяем узловой набор 2 (нижние узлы нижней опоры) 
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Шаг 17 

Определяем узловой набор 3 (верхние узлы верхней опоры) 

 

 

Шаг 18 

Определение графика нагружения на верхнюю опору 

 

 

Шаг 19 

Определение нагрузки на верхнюю опору 
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Шаг 20 

Полное ограничение узлового набора 2 

 

Шаг 21 

Ограничение узлового набора 3 

 

(кроме оси Z) 

Шаг 22 

Определение контакта 1 

 

HTC – теплопроводность; QCRIT – критический зазор для задания тепло-

вой проводимости; GMAX – максимальное значение зазора при котором 

тепловой контакт отсутствует; 
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Шаг 23 

Определение контакта 2 

 

 

Шаг 24 

Определение температуры 

 

Для всех неуказанных узлов 

Шаг 25 

Определение температуры заготовки 

 

!Важно не перепутать последовательность определения температуры! 
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Шаг 26 

Определение связного анализа 

 

 

Шаг 27 

Определение времени завершения 

 

 

Шаг 28 

Определение параметров теплового решателя 

 

Шаг 29 

Определение тепловых параметров для временного шага 

 

Шаг 30 

Определение выходных параметров ASCII 

 

Шаг 31 

Определение частоты записи выходных файлов 
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Шаг 32 

Сохранение файла 

 

Шаг 33 

Запуск на расчет 

 
 

Шаг 34 

Вывод по пластическим деформа-

циям 

 

Шаг 35 

Вывод по напряжению 
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Шаг 36 

Вывод по температуре 

 

Шаг 37 

Построение графиков выбранных 

элементов 

 
 

 

Шаг 38 

Вывод графиков из ASCII файлов 

 

Шаг 39 

Просмотр сечений 

 
 

Файлы: 

расчетная модель - 

Hot_metalforming.k 

https://dynacrash.ru/Workshop/Ex7.zip 

https://dynacrash.ru/Workshop/Ex7.zip
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Семинар 8. Прокатка заготовки между цилиндри-

ческими роликами 

Учебный видеоурок https://youtu.be/Td2xsoeGBpo 

 

Модель прокатки представлена двумя 

цилиндрическими роликами диаметром 

100 мм и шириной 50 мм и заготовкой 

55х20х4 мм. В исходном положении роли-

ки разведены и заготовка продвинута впе-

ред для контакта. В процессе прокатки ро-

лики сводятся и одновременно задается 

вращение. Заготовка представлена упруго-

пластической моделью, ролики твердой 

моделью. 

Шаг 1 

Создание конечно-элементной мо-

дели заготовки 

 

 

Шаг 2 

Создание конечно-элементной мо-

дели верхнего ролика 

 

Диаметр 100 мм, ширина 50 мм. 

Направление оси по z 

 

https://youtu.be/Td2xsoeGBpo
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Шаг 3 

Создание конечно-элементной модели нижнего ролика 

 

 

Шаг 4 

Определение модели материала заготовки 
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Шаг 5 

Определение модели материала ролика 1 

 

 

Шаг 6 

Определение модели материала ролика 2 

 

 

Шаг 7 

Определение типа элемента заготовки 
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Шаг 8 

Определение типа элемента роликов 

 

Толщина оболочки 1 мм 

 

Шаг 9 

Определение контроля искажения 

 

 

Шаг 10 

Определение части 1 (заготовка) 

 

Заготовка – Part 1 – Элемент Solid – Material 1 
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Шаг 11 

Определение части 2 (верхний ролик) 

 

Верхний ролик – Part 2 – Элемент Shell – Material 2 

 

Шаг 12 

Определение части 3 (нижний ролик) 

 

Нижний ролик – Part 3 – Элемент Shell – Material 3 
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Шаг 13 

Определение контакта заготовка - верхний ролик 

 

 

Шаг 14 

Определение контакта заготовка - нижний ролик 
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Шаг 15 

Определение графика нагружения 1 

 

График для вращения нижнего ролика 

Время = 0; 0.01; 0.1 

Угловая скорость = 0; 20; 20 

 

Шаг 16 

Определение графика нагружения 2 

 

График для вращения верхнего ролика 

Время = 0; 0.01; 0.1 

Угловая скорость = 0; -20; -20 
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Шаг 17 

Определение графика нагружения 3 

 

График перемещения нижнего ролика 

Время = 0; 0.01; 0.1 

Перемещение = 0; 3; 3 

 

Шаг 18 

Определение графика нагружения 4 

 

График перемещения верхнего ролика 

Время = 0; 0.01; 0.1 

Перемещение = 0; -3; -3 

Шаг 19 

Определение карты нагружения 1 
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Шаг 20 

Определение карты нагружения 2 

 

 

Шаг 21 

Определение карты нагружения 3 

 

 

Шаг 22 

Определение карты нагружения 4 
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Шаг 23 

Определение времени завершения 

 

 

Шаг 24 

Определение частоты записи выходных файлов 

 

 

Шаг 25 

Сохранение файла 
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Шаг 26 

Запуск на расчет 

 

 

Шаг 27 

Анимация процесса 

 

 

Шаг 28 

Просмотр по пластическим дефор-

мациям 

 

 

Шаг 29 

Просмотр по напряжениям 
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Шаг 30 

Вывод по кинетической энергии 

 

 

Шаг 31 

Просмотр параметров по одному 

элементу 

 
 

 

Файлы: 

расчетная модель – prokat.k 

https://dynacrash.ru/Workshop/Ex8.zip 

 

 

 

 

 

 

 

 

 

 

 

 

https://dynacrash.ru/Workshop/Ex8.zip
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Семинар 9. Разделительная операция – процесс 

резки 

 

Учебный видеоурок 

https://youtu.be/AQAuoXRh_EA?si=dG4_FyRBD4Npy7K 

 

 

Модель резки представлена инструментом и заготовкой. Заготовка - 

прямоугольный параллелепипед со сторонами 10х5х5 мм. Инструмент в 

виде более сложной фигуры с радиусом скругления 0,5 мм. Низ заготов-

ки закреплен. Скорость движения резца 5 м/сек. 

     Особенности данного процесса моделирования: использование модели 

материала Johnson-Cook с накоплением поврежденности, коэффициентов 

разрушения, уравнением состояния и дополнительными тепловыми па-

раметрами; учет нагрева заготовки в процессе резки; использование кон-

такта с учетом тепловых параметров процесса взаимодействия; использо-

вание контакта и самоконтакта. 

Принятая система измерения: длина – мм, масса – кг, время - мсек 

1 Построение геометрии ин-

струмента (резца). Постро-

ение геометрии инстру-

мента. Создание контура 

из линий 

 

Curve → Line 

1. Start Point X=0, Y=0, Z=0; End Point 5; 

1; 0 

2. Start Point 5, 5, 0; End Point 5; 1; 0 

3. Start Point 5, 5, 0; End Point 1; 5; 0 

4. Start Point 0, 0, 0; End Point 1; 5; 0 

2 Создание поверхности на 

основе линий 

Surf → FillPin 

Указываем поочередно на линии 
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3 Создание объемной гео-

метрии выдавливанием 

 

Solid → Extru 

Start Pos=0 

End Pos.=5 

Указать на  

геометрию 

 

5 Нанесение произвольной 

сетки на объемную гео-

метрию 

Mesh → SolidM 

Elem Size=1 

Try Meshing Automatically 

6 Сохранение файла File → Save → Save Keyword 

7 Создание заготовки 

 

Mesh → ShapeM → Box_Solid 

PMin X=-11, Y=-2.8, Z=0.5.  

PMax X=-1, Y=2.2, Z=4.5. 

Vx=10, Vy=8, Vz = 5 

8 Ввод параметров модели 

материала заготовки 

 

Model → Keywrd → 

*Mat_johnson_cook (015)* 

RO=7.81e-6, G=78.5, E=204, PR=0.3, 

A=0.553, B=0.601, N=0.234, C=0.0134, 

M=1, TM=1480, EPSO=0.001, CP=642, 

D1=1.2 

*проверьте что выбрана именно модель 

015 (первая) 

9 Определение модели мате-

риала ролика 

 

Model → Keywrd→ *Mat_rigid (020) 

R0=7.85e-6, E=200, PR=0.3, CM0=1, 

CON1=5, CON2=7 

10 Определяем тип элемента 

 

Model → Keywrd → *Section_solid 

ELFORM=2 

11 Определяем уравнения со-

стояния 

 

Model → Keywrd →  

*Eos_linear_ polynomial 

C1=170, V0=1 

12 Определение теплофизи-

ческих параметров мате-

риалов 

Model → Keywrd →  

*Mat_thermal_ isotropic (Т01) 

HC=642, TC=4.7e-5 

13 Определение части 1 (ре-

зец) 

 

Model → Keywrd → *Part* 

PID=1 SECID=1 MID=2 EOSID=0 

TMID=1 
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*ввод осуществляется нажатием на 

черные кружки 

14 Определение части 2 (за-

готовка) 

 

Model → Keywrd → *Part 

PID=2 SECID=1 MID=1 EOSID=1 

TMID=1 

15 Определение узлового 

набора из заготовки (необ-

ходимо для контакта) 

 

Model → CreEnt → Set Data → 

*Set_node. 

Наверху нажимаем Cre. В появившемся 

окне Sel. Nodes выбираем ByPart и ука-

зываем на заготовку 

16 Определение контакта 

 

Model → Keywrd →  

*Contact_ eroding_nodes_to_surface* 

SSTYP=4, MSTYP=3, SSID=1, MSID=1, 

FS=0.2, VDC=20, ISYM=1, EROSOP=1, 

IADJ=1, HTC=4.7E-5, LMIN=2, 

LMAX=1E4 

*сначало осуществляется выбор 3 и 4 

параметра 

17 Создаем карту для само-

контакта между частями 

заготовки 

 

Model → Keywrd →  

*Contact_ eroding_single_surface* 

SSTYP=3, MSTYP=3, SSID=2, MSID=2, 

FS=0.2, VDC=20, ISYM=1, EROSOP=1, 

IADJ=1 

*сначало осуществляется выбор 3 и 4 

параметра 

18 Определения кривой 

нагружения (для движения 

инструмента) 

Model → Keywrd → *Define_curve * 

(A1, O1): (0, 0); (0.02,-5); (5, -5) 

*Ввод осуществляется используя кнопку 

Insert 

19 Определение карты для 

работы малого рестарта 

 

Model → Keywrd → 

*Change_curve_definition 

LCID=1 

20 Определение движения на Model → Keywrd →  
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инструмент 

 

*Boundary_ Prescribed_motion_rigid 

PID=1, DOF=1, VAD=0, LCID=1 

21 Закрепление заготовки 

(полное ограничение низа 

заготовки) 

 

Model → CreEnt → Boundary → Spc 

Наверху нажимаем Cre. В появившемся 

окне Sel. Nodes выбираем Area и указы-

ваем на нижние узлы заготовки (2 ряда)  

22 Определение начальной 

температуры 

 

Model → Keywrd →  

*Initial_ temperature_set 

Temp=20 

23 Учет в балансе энергии 

различных составляющих 

 

Model → Keywrd → *Control_energy 

HGEN=2, RWEN=2, SLNTEN=2, 

RYLEN=2 

24 Определение связного 

анализа структура – тепло 

Model → Keywrd → *Control_ solution 

SOLN=2 

25 Определение времени за-

вершения 

Model → Keywrd → *Control_ termina-

tion 

ENDTIM = 1.5 

26 Определение контрольных 

карт по тепловой состав-

ляющей 

Model → Keywrd → *Control_ ther-

mal_nonlinear 

REFMAX=100 

27 Определение карты по 

тепловой составляющей 2 

 

Model → Keywrd → *Control_ ther-

mal_solver 

ATYPE=1, PTYPE=2, GPT=1 

28 Определение карты по 

тепловой составляющей 3 

 

Model → Keywrd → *Control_ ther-

mal_timestep 

ITS=1E-3, TMIN=1E-7, TMAX=1E-2, 

DTEMP=100 

29 Определение базы данных 

ASCII по энергии и усили-

ям 

Model → Keywrd → 

*Database_ASCII_option 

DT=0.003 Glstat, Matsum, Rcforc  

30 Определение частоты за-

писи 

 

Model → Keywrd → *Database_ bina-

ry_d3plot 

NPLTC=40 
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31 Определение частоты для 

рестарта 

 

Model → Keywrd → *Database_ bina-

ry_d3dump 

CYCL=1E6 

32 Определение контрольной 

карты контакта 

Model → Keywrd → *Control_ contact 

SLSFAC=0.5 

33 Сохранение файла File → Save → Save Keyword 

34 Запуск на расчет Запуск через LS-DYNA Manager 

35 Открываем plot файлы 

 

File → Open → LSDYNA binary plot 

Загрузка файлов d3plot 

36 Делаем анимация процесса Нижнее меню → Anim 

37 Вывод контуров по пара-

метру Von Mises stress 

Post → FriComp → Stress  →  

Von Mises stress 

38 Вывод контуров по пара-

метру Effective plastic 

strain 

Post → FriComp → Stress  →  

Effective plastic srtain 

39 Вывод контуров по темпе-

ратуре 

Post → FriComp → Misc  →  

temperature 

40 Построение графиков по 

сохраненным файлам 

glstat, matsum, rsforc 

Post → ASCII → glstat  →  

Internal Energy 

41 Вывод графика усилия 

 

Post → ASCII → rcforc  →  

Ma-1 → 4-Resultant Force 

42 Построение графиков из 

вкладки история 

Post → Histiry → Global  →  

Kinetic Energy 
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Приложение 1 

Темы для учебных заданий процессов обработки металлов для моделирования 

в LS-DYNA 

(Источник Филимонов В.И. ТОМД. Курсовая работа) 

 

№ 

темы 

Название темы Исходные данные Номер 

эскиза 

1.  Ковка длиной полосы на 

прессе. 
а=60мм; 300 h мм; 

25кh мм; s 0,3; 

l=800мм. 

Материал: Ст10, зерно . 

 

1 

2.  Осадка короткой полосы на 

прессе. 
H=40мм; 36кh мм; 

s 0,2; 

l=400мм; а=80мм. 

Материал: Ст6; зерно . 

 

     2 

3.  Протяжка сплошной заго-

товки в круглых бойках. 
600 h мм; d=80мм; 

s 0,25; 6h мм.  Мате-

риал: Ст6; зерно . 

 

     3 

4.  Протяжка полой заготовки в 

вырезных бойках с оправ-

кой. 

500 l мм; d=80мм; s 0,3; 

5h мм; S=25мм. 

Материал: Сталь5; зер-

но . 

 

     4 

5.  Разбортовка трубчатой за-

готовки.  
60мм; S=2мм; 030 . 

Материал: Ст2. 

 

      5 

6.  Волочение проволоки. .2.4;5 21 ммDммD   

Материал: Ст2. 

 

      6 

7.  Прокатка полосы из стали. ;2,1;6.10 ммSммS к    

  l = 600мм. Материал: 

Ст3. 

 

      7 

8.  Редуцирование трубной за-

готовки. 
;22300 ммDD k    l – са-

мостоятельно. Материал: 

Cт6. 

 

      8 

9.  Открытая прошивка плос-

кой заготовки. 
28; ;120 ммS   

Материал: Ст3. 

 

     9 

10.  Отбортовка плоской заго-

товки. 
D=30мм; в=5мм; ;5.10 ммS   

Материал: Ст2. 

 

    10 

11.  Осадка цилиндрической за-

готовки с внутренним от-

верстием, (горячая). 

D=120мм; 15;2  h
d

D
; 

H=80мм. Материал: Ст3. 

 

    11 

12.  Горячая осадка цилиндри-

ческой заготовки.  
D=60мм; ;8h H=84мм. 

Материал: Ст5. 

 

    12 
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№ 

темы 

Название темы Исходные данные Номер 

эскиза 

13.  Локальное расширение 

трубчатой заготовки внут-

ренним давлением. 

D=30мм; d=38мм; ;20 S  

Материал: Ст0. 

 

    13 

14.  Локальное обжатие трубча-

той заготовки с оправкой. 
D=40мм; d=32мм; ;20 ммS   

Материал: Ст0. 

 

    14 

15.  Штамповка выдавливанием 

осесимметричной детали, 

(горячая). 

D=140мм; d=42мм; 
;36;200 21 ммlммl   

Материал: Ст0.   

 

15 

16.  Открытая прошивка цилин-

дрической заготовки. 

(горячая) 

D=80мм; d=52мм; 

H=100мм; 

Материал Ст0. 

 

16 

17.  Закрытая прошивка цилин-

дрической заготовки, (горя-

чая) 

D=90мм; d=60мм; 

H=120мм; 

Материал Ст0. 

17 

18.  Гибка полосы моментом 
0S =4мм; l=130мм; 

 угол = 090 ; ммrrвн 2min    

 

 

18 

19.  Гибка полосы растяжением S=2мм; l=80мм; P=
6

Т ; 

ммrrвн 5.0min  ; угол 060 ; 

Материал Ст2; 

 

 

19 

20.  Вытяжка плоской заготовки D=120мм; d=80мм; 

H=0,85мм от max; 0S =1; 

Учет трения, наличие 

прижима;  Материал Ст0. 

 

20 

21.  Волочение проволоки в 

условиях противонатяжения  
D=12мм; d=8мм; Тз кР       

(при различных значениях 

провести анализ) 

 

21 

22.  Прессование полосы через 

суживающуюся матрицу 

(нагрев) 

Н=30мм; h=22мм; 

l=160мм; 

Материал Ст0. 

 

22 

23.  Волочение трубы на оправ-

ке (нагрев), (цилиндр проб-

ка) 

D=22мм; 0S =4; КS =3,2мм; 

(расчеты); { различые 

схемы и уравнения для 

них (Гофман и Закс )};  

Материал Ст2. 

 

 

23 

24.  Прокатка листа с натяжени-

ем на входе  
Н=6мм; 5Kh мм; l=400мм; 

кP Твх  ; 

Материал Ст. 

 

24 
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№ 

темы 

Название темы Исходные данные Номер 

эскиза 

25.  Вытяжка заготовки с утоне-

нием стенки 
D=60мм; d=40мм; 0S =2; 

КS =1,5мм; 

Материал Ст6 

 

26 

26.  Прокатка листа с натяжени-

ем на выходе  

Н=6мм; h=5мм; l=400мм; 

Твых кР  ; 

Материал Ст2. 

24 

27.  Волочение проволоки при 

кулоновском трении 

D=6мм; d=4мм; 

Материал Ст3. 

6 

28.  Обкатка заготовки D=30мм; 
5

1 ; l=60мм; 

2.10 S мм. 

 

– 

29.  Раздача трубы заготовки  D=40мм; 
6

1 ; l=60мм; 

50 S мм; 

Материал Ст3. 

 

 

5 

30.  Гибка широкой полосы S=3мм; 5.4вr мм; 
090 мм; l=70мм; Мате-

риал Ст3. 

 

18 

31.  Вытяжка с утонением стен-

ки 

H=70мм; d=56мм; 
;8.10 ммS  ;2.1 ммSK   

20 

32.  Гибка профиля в роликах 2.10 S мм; ;2ммrB   

Материал Ст3. 

 

– 

33.  Гибка с торцовым  сжатием 5.10 S мм; ;2ммrB   

Материал 0,8кп. 

 

18* 

34.  Профилирование листовой 

заготовки в валках. 

НДС в уголковой зоне: 

5.2вr мм; S=2мм.  

 

– 

* – со смещенным центром вращения поворотной траверсы 

Примечание: Схемы и параметров процесса к расмотрению могут пол-

ностью или частично изменяться от года к году по усмотрению препо-

давателя. 
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 185 

Приложение 2 

Учебный курс «Моделирование ударов и разрушения в программе LS-DYNA» 

 

Цель: Подготовка к пользованию LS-Dyna позволит овладеть навыками моделирования процессов 

удара и разрушения. Пользователи научатся создавать достоверные расчетные модели, запускать 

процесс решения задачи и анализировать полученные результаты в препостпроцессоре LS-prepost. 

Объем подготовки: 40 (сорок) часов.  

Форма подготовки: очно или online. 

 

№ Наименование консультационных услуг Всего 

часов 

1. Введение 2 

 - основы теории явного метода динамики; 

- особенности решения задач явными методами динамики; 

- критический шаг интегрирования; 

- применение программы LS-Dyna для задач удара; 

- методы расчета в LS-Dyna. 

 

2. Введение в LS-Dyna 6 

  - структура пакета LS-Dyna; 

- этапы проведения расчета; 

- структура файлов; 

- постановка задач удара в LS-Dyna; 

- создание карт; 

- применение препроцессора ls-prepost;  

- единицы измерения. 

- методы расчета в LS-Dyna (FEM, ALE, SPH, EFG, SPG). 2D методы решения. 

Упражнение:   

- изучение препостпроцессора LS-prepost; 

- создание геометрии для моделировании процессов удара. 

 

3. Создание сеточной геометрии в LS-Dyna 2 

  - требования; 

- импорт геометрии; 

- задание размеров элементов; 

- методы создания конечно-элементных моделей; 

- создание конечно-элементной сетки; 

- Упражнение:  Импортирование исходной геометрии. Создание сеточной геомет-

рии в препроцессоре LS-prepost. 

 

4 Определение моделей материала 6 

 - линейно-упругий материал; 

- пластический материал; 

- жесткий материал; 

- композитный материал; 

- уравнения состояния материала; 

- идентификация параметров моделей упругопластичности; 

- модели накопления поврежденности и разрушения материала (GISSMO); 

Упражнение:  

- моделирование процесса 

деформирования. испытание материала на растяжение.  

- кривые упрочнения;  

- определение параметров разрушения материала; 

- определение тепловых параметров материала. 

 

5 Определение типов элемента 2 
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 - обзор существующих типов элемента; 

- объемный элемент; 

- оболочечный элемент; 

- SPH элемент; 

- ALE элемент (ейлеровый подход) 

- интегрирование элемента; 

- паразитные формы (hourglassing).  

 

6 Определение нагружения и граничных условий 2 

 - определение нагружения; 

- определение начальной скорости; 

- демпфирование; 

- определение узловых наборов; 

- типы ограничений; 

- определение неотражаемых границ 

 

7 Определение контактного взаимодействия 5 

 - алгоритмы контактного взаимодействия; 

- типы контакта; 

- определение контакта; 

- расширенные параметры контакта; 

- определение параметров расчета для методов ALE, SPH. 

Упражнение:   

Моделирование процесса удара шара об препятствие.  

 

8 Настройка параметров расчета 2 

 - шаг интегрирования; 

- настройка решателя;  

- демпфирование; 

- адаптивное разбиение; 

- варианты запуска файла на расчет; 

- прерывание решения и рестарт. 

Упражнение:   

Моделирование процесса удара шара об препятствие (определение остальных па-

раметров); 

 

9 Анализ результатов 3 

 - визуализация результатов; 

- секущие плоскости; 

- таблицы и графики;  

- векторные результаты; 

- анимации. 

Упражнение:   

- Моделирование процесса удара шара об препятствие (анализ результатов); 

 

10 Рекомендации 10 

 - основные рекомендации. 

Упражнение:   

- моделирование дроп-теста (падения); 

- моделирование удара и разрушения об жесткое препятствие. грунт; 

- моделирование удара и разрушения пули о преграду методом FEM, ALE, SPH 

- моделирования удара птицы об элементы двигателя методом SPH; 

- моделирование удара об воду методом ALE, SPH; 

- моделирования удара и разрушения об композитный слоистый материал; 

- моделирование краш-теста с манекеном 

- выполнение индивидуальных заданий. 

 

 ИТОГО 40 

 

Составитель: Илюшкин Максим Валерьевич 

Подробности по e-mail: fzbm@mail.ru 
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Приложение 3 

Учебный курс «Моделирование процессов обработки металлов в программе 

LS-DYNA» 

 

Цель: Подготовка к пользованию LS-Dyna позволит овладеть навыками моделирования процессов 

ОМД: листовой и горячей штамповки и механообработки. Пользователи научатся создавать досто-

верные расчетные модели, запускать процесс решения задачи и анализировать полученные резуль-

таты в препостпроцессоре LS-prepost. 

Объем подготовки: 40 (сорок) часов.  

Форма подготовки: очно или online.  

 

№ Наименование консультационных услуг Всего 

часов 

1. Введение 4 

 - основы теории явного метода динамики; 

- особенности решения задач явными методами динамики; 

- критический шаг интегрирования; 

- применение программы LS-Dyna для задач ОМД; 

- методы расчета LS-Dyna. 

 

2. Введение в LS-Dyna 4 

  - структура пакета LS-Dyna; 

- этапы проведения расчета; 

- структура файлов; 

- постановка задач ОМД в LS-Dyna; 

- создание карт; 

- применение препроцессора ansys workbench и  ls-prepost;  

- единицы измерения. 

- методы расчета в LS-Dyna (FEM, ALE, SPH, SPG). 2D методы решения. 

Упражнение:   

- изучение препостпроцессора LS-prepost. 

- создание геометрии заготовки и инструмента при моделировании процессов 

ОМД. 

 

3. Создание сеточной геометрии в LS-Dyna 2 

  - требования; 

- импорт геометрии; 

- задание размеров элементов; 

- методы создания конечно-элементных моделей; 

- создание конечно-элементной сетки; 

- Упражнение:  Импортирование исходной геометрии. Создание сеточной геомет-

рии заготовки и инструмента. 

 

4 Определение моделей материала 6 

 - линейно-упругий материал; 

- пластический материал; 

- материал с анизотропией; 

- жесткий материал; 

- уравнения состояния материала; 

- идентификация параметров моделей упругопластичности; 

- модели накопления поврежденности и разрушения материала (GISSMO); 

Упражнение:  

- моделирование процесса 

деформирования. испытание материала на растяжение.  

- кривые упрочнения;  

- определение формуемости материала, 

- определение параметров разрушения материала. 

- определение тепловых параметров материала 

- моделирование процесса нагрева и охлаждения заготовки. 
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5 Определение типов элемента 2 

 - обзор существующих типов элемента; 

- объемный элемент; 

- оболочечный элемент; 

- интегрирование элемента; 

- паразитные формы (hourglassing).  

 

6 Определение нагружения и граничных условий 2 

 - определение нагружения; 

- определение начальной скорости; 

- демпфирование; 

- определение узловых наборов; 

- типы ограничений. 

 

7 Определение контактного взаимодействия 5 

 - алгоритмы контактного взаимодействия; 

- типы контакта; 

- определение контакта; 

- расширенные параметры контакта; 

- моделирование пружинения. 

- Определение параметров расчета для методов ALE, SPH, SPG. 

Упражнение:   

Моделирование процесса деформирования и разрушения.  

 

8 Настройка параметров расчета 2 

 - шаг интегрирования; 

- настройка решателя;  

- демпфирование; 

- адаптивное разбиение; 

- варианты запуска файла на расчет; 

- прерывание решения и рестарт. 

Упражнение:   

- моделирование процесса холодной и горячей штамповки (Определение осталь-

ных параметров); 

 

9 Анализ результатов 3 

 - визуализация результатов.  

- секущие плоскости.  

- таблицы и графики.  

- векторные результаты.  

- использование диаграмм предельной формуемости FLD 

- анимации.   

Упражнение:   

- моделирование процесса холодной и горячей штамповки (анализ результатов); 

 

10 Рекомендации 10 

 - основные рекомендации; 

- параметры для моделирования листовой штамповки. 

Упражнение:   

- моделирование процесса деформирования листового и объемного материала с 

адаптивным перестроением; 

- моделирование процесса ковки; 

- моделирование процесса объемной горячей штамповки методом ALE, SPH, SPG. 

- моделирование процесса горячей прокатки листа. 

- моделирование процесса вытяжки  

- моделирование процесса вырубки; 

- моделирование процесса резания металла резцом (точенее) 

- моделирование процессов фрезерования и сверления 

- выполнение индивидуальных заданий. 

 

 ИТОГО 40 

Составитель: Илюшкин Максим Валерьевич 

Подробности по e-mail: fzbm@mail.ru 
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Приложение 3 

Видеоуроки “Моделирование в программе LS-DYNA” 

 

Видеоуроки представляют собой методики по созданию расчетных мо-

делей различных процессов для LS-DYNA 

В видео представлена полная посделовательность дефствий по созданию 

расчетной модели, запуска в решателе LS-DYNA и анализа результатов 

В качестве решателя используется версия LS-DYNA R10.3 

 

№ Название Длительность, 

мин 

1 Удар шарика о воду 22 

2 Удар контейнера с водой 27 

3 Падение воды в контейнер 23 

4 Перелив жидкости в контейнер 20 

5 Моделирование гидроабразивной резки 28 

6 Воздействия волн на лодку методом ALE 53 

7 Воздействия волн на лодку методом SPH 46 

8 Точение методами ALE, EFG, SPG, EFG, Peri 10-30 

9 Моделирование износа  16 

10 Моделирование вытяжки листовой детали 60 

11 Моделирование сверления 56 

12 Моделирование электрогидроимпульсной штамповки 60 

13 Идентификация моделей материала 120 

14 Модели разрушения в LS-DYNA 80 

15 Деформирования заготовки методом ISF (точечное 

деформ.) 

24 

16 Моделирование фрезерование  40 

17 Моделирование раскатки уголка 28 

18 Моделирование взрывной нагрузке в контейнере SPH 

/ ALE 

30/51 

 

Составитель видеоуроков: Илюшкин Максим Валерьевич 

Подробности по e-mail: fzbm@mail.ru 
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АО “Ульяновский НИАТ” - одно из ведущих предприятий России, 

которое более 40 лет разрабатывает и производит профилегибочное обо-

рудование. При разработке технологических процессов используется 

средства компьютерного моделирования, имеет коммерческую лицензию 

программы LS-DYNA - http://ulniat.ru 

Базовая кафедра “Технологии ЗШП” при УлГТУ проводит 

учебную и научную работу с технологиями обработки листовых матери-

алов с использованием средств компьютерного моделирования процессов 

https://vk.com/club130155677 

Информационная поддержка ЗАО «КАДФЕМ Си-Ай-Эс» - ANSYS, 

лицензирование, внедрение, консалтинг - http://www.cadfem-cis.ru 

 

Составитель материалов курса лекций Илюшкин Максим Валерье-

вич, к.т.н., e-mail: fzbm@mail.ru  

Опыт применения программы LS-DYNA более 15 лет. Шесть кур-

сов обучения у инструкторов LSTC, Dynaform, Dynamore (Paul DuBios, 

Art Shapiro, M`hamed Souli и др.). 

 

 

Нащ сайт, посвя-

щенный модели-

рованию 

 

https://www.dynacrash.ru 

 

Наши примеры 

моделирования 

(Youtube) 

 

https://www.youtube.com/playlist?list=PL95PBAKBuLSvI0j7dtXrgdMCoy4T8B9nB 

 

Примеры модели-

рования краш-

тестов 

https://www.youtube.com/playlist?list=PLc4h3kfWwlZ5dbZ5Kiii0hFbXISpUtZxb 

 

Группа в контакте 

“Металлобработка: 

моделирование, 

обучение LS-

DYNA” 

 

https://vk.com/ultzshp 

 

Видеоуроки в LS-

DYNA (rus) 

 

https://www.youtube.com/playlist?list=PL95PBAKBuLSuydUmRjZzay9UlMjO658t9 

 

 

http://ulniat.ru/
https://vk.com/club130155677
http://www.cadfem-cis.ru/
https://www.dynacrash.ru/
https://www.youtube.com/playlist?list=PL95PBAKBuLSvI0j7dtXrgdMCoy4T8B9nB
https://www.youtube.com/playlist?list=PLc4h3kfWwlZ5dbZ5Kiii0hFbXISpUtZxb
https://vk.com/ultzshp
https://www.youtube.com/playlist?list=PL95PBAKBuLSuydUmRjZzay9UlMjO658t9

